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INTRODUCTION 
 
This user’s manual describes the features of the Studio302 application. 
 
Studio302 is the user-friendly, easy-to-use software tool that integrates all applications included in 
Smar's Enterprise Automation package, the System302. Studio302 does not incorporate the 
functionality of the applications, Studio302 only starts the selected application, and each software 
application is executed apart from the others. 
 
One of the Studio302 characteristics is managing the information from different plant project 
configurations imported to a single integrated database. This enables integration of all control, 
operation, and maintenance tools to several workstations. 
 
The access rights defined for each engineer or technician operating the plant process guarantee the 
integrity of the project configuration data. Specific user groups for Studio302 can be created by the 
operational system in the workstation and they are transparently incorporated to the Studio302 
login system. 
 
Allowing simultaneous access to different users minimizes repetitive re-configuring of the same 
project to different client machines. It also maintains continuous data flow for file transfer. 
 
With Studio302, the maintenance of the plant instruments is more efficient. Using the Wizard, the 
user can perform the maintenance and even replace an instrument in an effective way, reducing the 
idle time of the plant. 
 
Studio302 runs on Microsoft® Windows. If the user needs further information about versions and 
types of supported operating systems, refer to the README of SYSTEM302. 
 
This manual refers to version 1.12 of Studio302. 
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Section 1 
 

1.1 

INSTALLATION AND CONFIGURATION 
 

Installation and Configuration 
 
Studio302 is installed by the SYSTEM302 Installation media, along with all the other integrated 
applications you will use to configure, maintain and supervise your plant. 
 
Please refer to the SYSTEM302 HANDBOOK, which describes the procedures to install and 
configure SYSTEM302. 
 
 

Starting Studio302 
 
After configuring your system using the System302 Settings tool, you can start using Studio302. 
On the Start menu, click Programs > SYSTEM302 > Studio302 to run the application. 
 
The first time Studio302 is executed on the local machine, it is not necessary to type the username 
and password to gain access to the SYSTEM302 tools. 
 
To enable the secure mode, click Settings > Security, and click Enable Login. 
 
After changing this definition, users must log in every time the Studio302 is initialized. Studio302 
incorporates Windows User Groups. Windows’ users can log to Studio302 using the same login 
name and password configured for the operating system. 
 
The figure below shows the Login dialog box: 
 

 
Figure 1.1. User Login 

 
Type the user’s login and password and click Login. Click Cancel to cancel the login procedure and 
the Studio302 application will close. 
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Changing the Current Studio302 User 
 
It is not necessary to close the Studio302 application to change the user logged to the application. 
On the File menu, click the option Log Off to change the current Studio302 user. 
 
A message box will open to confirm the operation: 
 

 
Figure 1.2. Confirm the Log Off procedure 

 
 
Click Yes and the Login dialog box will open. Type the name and password of the new user to 
connect to the Studio302 again. 
 
If the user clicks Cancel on the Login dialog box, the Studio302 application will be shut down. 
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2.1 

USER INTERFACE 
 
The figure below shows the Studio302 interface: 
 

 
Figure 2.1. Studio302 Interface 

 
The left panel shows shortcuts to open the windows from where the user can access the information 
related to strategy controls, logics, workstations, controllers, I/O points, and field devices, created in 
areas configuration files managed by Studio302. 
 
The following subsections describe the toolbars, their functionality, and how the users access the 
plant process control information. 
 
 

Toolbars 
 
Studio302 has two toolbars located under the main menu: 
 

 
Figure 2.2. Studio302 Toolbars 

 
 
Main toolbar 
 

 - Show/Hide the Topology 
Click this button to open or close the left panel that displays the topology tree in Studio302. 
 
 

 - New Detect Devices List 
Click this button to open the window with the list of new devices detected that can be added to the 
plant. See the figure below: 
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Figure 2.3. New field device detected window 

 
See section Detecting New Devices. 
 

 - Database 
Click this button to open the Database window. See section Database for details. See the figure 
below: 
 

 
Figure 2.4. Database Configuration Window 

 

 - Reports 
Click this button to generate the reports related the SYSTEM302 tasks, the active instruments from 
the current Database, the Firmware versions, or the SYSTEM302 files installed on the local machine 
along with the local machine hardware description. 
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It is not possible to generate two or more reports simultaneously. Only one report window can be 
shown at a time in the Studio302 window. 
 
The following dialog box will open: 
 

 
Figure 2.5. Choose a Report 

 
Click the option Checking to generate the report that indicates the instruments (field devices and 
controllers) from the current database which are communicating to the system. This report will show 
the instrument tag, Device ID, the revision of the Device Description (DD) and the instrument 
revision. 
 
The communication servers (HSE Server, DFI Server, DD Server e AE Server) must be active on 

the local machine to generate this report. Click the button  Online/Offline Communication to 
activate the servers. 
 
See the example in the figure below: 
 

 
Figure 2.6. Checking Report 

 
Click the option Firmwares to generate the report that indicates the versions and date of each 
installed firmware. See the example in the figure below: 
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Figure 2.7. Firmwares Report 

 
Click the option Inventory to generate the report that lists all files located in the SYSTEM302 
installation folder and indicates the hardware characteristics for the local machine (where 
SYSTEM302 was installed). 
 
This report has two sections. The Hardware section shows the configuration of the local machine, 
including the machine name, operating system version, hard disk space, network adapters, etc. The 
Software section reports the SYSTEM302 version and the number of files related to this installation. 
 
See the example in the figure below: 
 

 
Figure 2.8. Inventory Report 

 
Click the Processes option to generate the report that indicates all processes that are running on 
the station, the related products, their versions and the memory space occupied by them. 
 
See the example in the following figure: 
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Figure 2.9. Processes Report 

 
Click the option System302 Tools to generate the report that indicates the version, installation path 
and status of each application available with SYSTEM302. See the example in the figure below: 
 

 
Figure 2.10. Tasks Report 

 

 - Process Equipment Database 
Click this button to open the Process Equipment Database window. See the following figure: 
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Figure 2.11. Process Equipment Database Window 

 
See section Process Equipment Database. 
 
 

 - Pack & Go 
Click this button to compact all system information, such as configuration files, block support and 
device support files, into a single file to be copied to a remote machine.  
 
See section Pack & Go. 
 

 
Figure 2.12. Pack & Go Options 

 

 - Unpack 
Click this button to unpack a compacted file that contains the information about a remote system, 
which will be copied to a local machine. See section Unpacking Database Files. 
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Figure 2.13. Unpacking files 

 
 

 - Diagnostics 
Click this button to open the Diagnostics window. See section Diagnostics. 
 

 
Figure 2.14. Diagnostics Window 

 
 

 - Update All 
Click this button to update the information of all configurations saved on the Database Manager. 
This procedure is available in the Multi-User mode. 
 
 

 - Online/Offline Communication 
Click this button to toggle between the online and offline communication mode. This button also 
activates the detection service for new devices connected to the communication network. 
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Tasks toolbar 
 
These buttons are related to the SYSTEM302 applications. The following list indicates the 
correspondence with the applications: 
 

 Area Link Configuration (Area Link Tool) 

  Asset Management (AssetView) 

  DFI Diver 

  Firmware Download (FBTools Wizard) 

  Network Analysis (FBView) 

 FDT Hart Configurator (AssetView) 

  License Information (LicenseView) 

  IEC-61131 Ladder Logic Configuration (LogicView) 

  Profibus PA Device Parametrization (ProfibusView) 

  ProcessView 

 OPC Server Management (System302 Server Manager) 

 OPC Tag Visualization (TagView) 

  Strategy Configuration (Syscon) 

 Strategy Simulation (SimulationView) 

 Tag List Generator for DF65 (TagList) 

 System302 Documentation 
 
When you click these buttons, the corresponding application is initialized. Studio302 does not 
incorporate the functionality of the application; Studio302 only initializes the selected application, 
and each software application is executed apart from the others. 
 
Customizing the Toolbars 
 
You can select the applications that will be initialized from the toolbar. Go the Settings menu and 
select the option Toolbar. The dialog box to select the applications will open. 
 

 
Figure 2.15. Selecting the Studio302 Applications 
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• To enable the button for an application in the toolbar, select the icon of the application in the 

Available toolbar buttons list and click Add. 
 

• To disable the button for an application in the toolbar, select the icon of the application in the 
Current toolbar buttons list and click Remove. 

 
If the button for an application is not available in the dialog box showed above, it means that the 
application was not installed by SYSTEM302. 
 
 

Topology Tree 
 

To open the topology tree, click the button Show/Hide Topology , or go to the File menu and 
select the option Topology. 
 
To close the topology tree, click the button Show/Hide Topology again or go to the File menu and 
unselect the option Topology. 
 
You can expand the visualization area hiding the topology tree of Studio302. 
 
Click the button Hide Topology , and the topology tree will collapse to the left, increasing the 
visualization area. 
 

 
Figure 2.16. Hiding the topology tree 

 
To display the topology tree again, move the mouse cursor over the SYSTEM302 label. The name 
displayed on the label of the left panel corresponds to the name of the current Database. 
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Figure 2.17. Displaying the topology tree 

 
 

Defining User's Preferences 
 
On the File menu, click the option Preferences to configure the user's preferences. 
 
Path to Configurations Removed from the Database 
 
If a configuration is removed from the current Database, the files related to this configuration are 
moved from the Studio302 working directory to a directory defined by the user. 
 
In case it is necessary to restore that configuration, import the configuration file again, from the 
directory defined by the user to the current Database and all files related to the configuration will be 
restored to the Studio302 working directory. 
 

 
Figure 2.18. Preferences Dialog Box: Files Tab 

 
Click the Browse button to open the Browser dialog box. Browse the directories to locate the 
folder, select the folder icon and click Ok to conclude. 
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Process Equipment Database 
 
Define the database of the Process Equipment Database. 
 
Click the Process Equipment Database button to open the Data Link Properties dialog box and 
select the server. You can also test the connection with the database clicking the Test Connection 
button. 
 

 
Figure 2.19. Preferences Dialog Box: Process Equipment Database Tab 

 
If you select a remote data server, it will only be possible to view the data information and you will 
not be allowed to alter the Process Equipment Database items. In this case, the Process 
Equipment Database will be operating in View Mode. 
 
 
SimulationView 
 
This option enables the simulation mode of the SYSTEM302. For further information, please, refer 
to the SimulationView manual. 
 

 
Figure 2.20. Preferences Dialog Box: SimulationView Tab 
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Manufacturer ID 
 
The profile numbers are grouped according to the Manufacturer IDs. 
 

 
Figure 2.21. Preferences Dialog Box: Manufacturer ID Tab 

 
• Unique: select this mode to define a default Manufacturer ID for all databases. 

 
• Engineering: select this mode to specify a Manufacturer ID for each database created. 

 
 
Samples Screen 
 
Check the option Enable the Studio302 Samples to open the Samples Screen every time the user 
starts the Studio302. If this option is not checked, the Samples Screen will not appear. 
 

 
Figure 2.22. Preferences Dialog Box: Samples Tab 

 
See sections Configuration Samples and Process Equipment Database Samples for details on 
how to open a Studio302 Sample. 
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Field Devices List Results 
 
Check this option to enable the dialog box that displays the status after reading the information 
related to the devices from each configured OPC Server. 
 

 
Figure 2.23. Preferences Dialog Box: Field Devices List Results Tab 

 
 
Reports 
 
Check the option Generate the Inventory Report when Studio302 is started to generate that 
report each time Studio302 is launched. This report lists all files related to SYSTEM302 and 
indicates the hardware characteristics for the local machine (where SYSTEM302 was installed). 
This report is generated transparently to the user. You can use the Backup Wise Inspector to 
compare the first and the last inventory report generated. 
 
Check the option Do not compare image and video files to skip the comparison of image and 
videos files when generating a report with Wise Inspector. The Wise Inspector tool is used by 
Smar Tech Support team to troubleshoot system configurations. 
 

 
Figure 2.24. Preferences Dialog Box: Reports Tab 
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License Monitor 
 
The License Monitor window shows the number of licensed devices, Process Equipment 
Database items and blocks according to the user’s software licenses and periodically checks the 
number of points being used by the configuration files and the points available for the project 
configurations. 
 

 
Figure 2.25. Preferences Dialog Box: License Monitor Tab 

 
Refresh Time: set the time interval (in minutes) to refresh the information related to the licenses for 
the SYSTEM302 applications in the License Monitor dialog box. 
 
Low Limit Percentage: set the minimum percentage of the number of licensed points (devices, 
items or blocks). If the number of available points is inferior to this percentage, the indicative number 
will be displayed in red. 
 
Average Limit Percentage: set the average percentage of the number of licensed points (devices, 
items or blocks). If the number of available points is inferior to this percentage, the indicative number 
will be displayed in orange. 
 
 
Diagnostics 
 
From the Diagnostics window, open the Devices Summary dialog box and monitor instruments 
with maintenance, diagnostic and tracking events. Also, open the Live Links dialog box and 
periodically check the block links created using Syscon and their state. 
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Figure 2.26. Preferences Dialog Box: Diagnostics Tab 

 
Auto Start: mark this option to automatically start monitoring the devices on the Devices Summary 
dialog box. 
 
Consider an oscillating link after ## seconds: set the time interval to wait until stabilizing the 
reading of the status of each link, before considering the link as oscillating on the Live Links dialog 
box. 
 
 
Replicate 
 
In the Replicate tab, the user will configure the databases number by spreadsheet that will be 
replicated. The options are 250, 500, 750 or 1000 databases. The time interval between replications 
can also be configured, ranging from 2 to 20 seconds. 
 

 
Figure 2.27. Preferences Dialog Box: Replicate 
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Section 3 
 

3.1 

CONFIGURING THE COMMUNICATION 
NETWORK 
 

Communication Settings 
 
To configure the communication in Studio302, go to the Settings menu and click the option 
Communications. 
 
The Communication Settings dialog box will open. 
 
 
Detect Device 
 
At the Detect Device tab, you can set the time interval to detect a device in your communication 
network. 
 

 
Figure 3.1. Communication Settings Dialog Box: Detect Device Tab 

 
• Stabilizing Time: Set the time interval, in seconds, that the server will wait until the device 

is stable in the network, before alerting the user the device was detected. 

• Strategy Operation Time: Set the time interval, in seconds that the server will wait while 
the device is commissioned or decommissioned. After this interval, if the device does not 
conclude the operation, all events sent by the device will be discarded. 

 
Click Apply to confirm the configuration and apply the changes. The default values are those 
recommended, in case of doubt, contact Smar technical support. 
 
 
Servers 
 
At the Servers tab, you can configure the communication server. 
 
If the Local server is selected, choose the Server ID from the list and click the Add to list button to 
include this server to the list of selected servers. To remove a server from the list of selected 
servers, select the icon of the server and click Remove. 
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Figure 3.2. Communication Settings Dialog Box: Servers Tab 

 
If the Remote server is selected, click the Browse button to locate the server machine. The 
Browser Network dialog box will open. Select the icon of the target machine and click Ok. 
 

 
Figure 3.3. Browser Network dialog box 

 
 
Services 
 
At the Services tab, you can alter the initialization mode for the device detection service. 
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Figure 3.4. Communication Settings Dialog Box: Services Tab 

Click the button Start to initialize the service manually. To stop the service, click the button Stop. 

When the detection service is active, the Studio302 icon appears in the Windows taskbar, as 
indicated in the figure below: 

Figure 3.5. Detecting New Devices 

The device detection service is also active when you start the communication clicking the 

Online/Offline Communication button, . 

System302 ServerManager Settings 

Click the button  to execute the System302 ServerManager. For detailed information refer to 
Appendix A in this manual that describes the System302 ServerManager application. 

Figure 3.6. Configuring the System302 ServerManager 
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Network Settings 
 
Click the link Network to configure the Network Interface Cards used by the System302 
ServerManager: 
 

• At the General tab, configure the number of NICs (Network Interface Cards) and the IP 
addresses. 

• At the HSE Redundancy tab, configure the Device and LAN redundancy. 
• At the Advanced tab, configure the synchronization and the schedule for the supervisory. 
• The HSE Maintenance tab is only available for users with Administrator rights and allows 

the administrator to delete the files related to the HSE persistency. 
• At the SNTP tab, configure the Application Clock Time. This option is used to configure the 

parameters related to the time synchronism. 

• The RTU tab must be configured only if the application uses remote access. Through this 
tab, the RTU mode is enabled or disabled, and the necessary parameters are configured 
for proper operation. 

 
Log Settings 
 
Click the link Logs to configure the options to enable or disable the log messages. 
 
Startup Settings 
 
Click the link Startup to configure the System302 ServerManager to automatically start the OPC 
servers when the operating system is starting up. 
 
When an OPC server is active, the icon of the System302 ServerManager will change to green 

( ) on the Windows taskbar. 
 

If the server is stopped, the icon of the System302 ServerManager will change to red ( ) on the 
Windows taskbar. 
 
Refer to the tutorial Network Settings for further information on how to configure the network 
servers or refer to Appendix A in this manual that describes the System302 ServerManager 
application.  
 
 
OPC Settings 
 
Click the link OPC to configure the options related to the Smar’s OPC Servers: 
 

• At the SNMP tab, configure the list of available agents and their supervision settings. 
• At the A&E tab, create the database with the initial conditions for the Smar A&E OPC 

Server to identify which events will be monitored. 
• At the HDA tab, configure the options to execute maintenance on the database related to 

the Smar’s Historical Data Access Server. 
• The UA tab provides access to the wrapper that provides the HSE Server for the UA 

standard. 

 



Section 4 
 

4.1 

USING STUDIO302 
 

Defining the Site Name 
 
To define a new name for the site, click the first topic in the topology tree. For example: 
 

 
Figure 4.1. Defining the Site Name 

 
The Site dialog box will open. Type the new name and click Ok to conclude. 
 

 
Figure 4.2. Type the new Site Name 

 

Database 
 
Database functionally corresponds to the Studio302 workspace that groups the configuration data 
of the plant (logic, control modules, equipment, etc.). The information is stored in the file with the 
extension *.scw. 
 

Click the button Database  in the main toolbar to display the Database information. The 
Database dialog box will open: 
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Figure 4.3. Database dialog box 

 
The field Current Database indicates the name of the current Database. 
 
 
Creating a Database 
 
A database can only be created in the Client/Server mode, when the Database Manager is being 
executed. 
 
In the Database dialog box: 
 

1. Select the option New and type the name for the new Database in the text field. The files 
for all Databases are created in the Studio302 default. 
 

2. In the Manufacturer ID box, click Browse to open the ManufacturerID dialog box. Select 
the All tab and click the name related to the desired Manufacturer ID. The profile numbers 
related to the selected Manufacturer ID will be used in the new Database. Click Ok to return 
to the Database dialog box. 

 
3. In the Database dialog box, click Ok to create the Database. A message box will open 

confirming the operation. Click Ok to conclude and the Database will be displayed in the 
Studio302 window. 
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Figure 4.4. Creating a Database 

 
 
Changing the Current Database 
 
To change the Database displayed in the Studio302 window, open the Database dialog box 

clicking the button  and select the icon corresponding to the desired Database. 
 
Click Ok and the message box will open to confirm the operation. 
 

 
Figure 4.5. Changing the Current Database 

 
Click Yes to conclude and change the Database. A message will appear to confirm the operation. 
 
 
Importing Syscon Files to the Database 
 
To import an existent configuration file to the current Database, go to the File menu, select Import 
and click Syscon file. The dialog box to import the configuration file will open. 
 
Browse the directories to locate the configuration file. Select the file icon and click Open to import 
the configuration. 
 
The Syscon window will open while the configuration is added to the Studio302. 
 
A message box will open informing the user that the configuration was imported by Studio302, 
indicating the corresponding Database. 
 

1 

3 

2 
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Figure 4.6. Importing Files 

 
Click Ok to close the message box and return to the Database. 
 
To list all the configurations included in a Database, click the icon Areas in the topology tree, and 
the list of the configurations will be displayed. In the Areas dialog box, double-click the project icon 
to open the configuration in the Syscon application. 
 

IMPORTANT 

The Database Manager manages all configuration files, and the configurations created using 
Syscon are saved in a common storage directory where all machines connected to the 
communication network can access those files. 
It is important to have a common practice to name tags in your company, to avoid consistency 
problems. 
For example, in Multi-user mode, if User A creates a configuration in a machine with the same 
name that User B created the configuration in another machine, one of the configuration files will 
be deleted and overlaid by the other file, when the configurations are committed. 
Likewise, it will not be possible to import a project configuration that contains the same tag for two 
or more control modules (or devices, blocks, etc) of another project configuration file already 
included in the Database. 

 
 
Databases Replication 
 

a) Prerequisites 
• Spreadsheet editor (LibreOffice, Office) installed on the workstation. 
• System302 version 8 or higher installed on the workstation. (Note: see requirements for 

installation). 
• Follow the steps below for the database replication process to work correctly. 

 
b) Creation of the database that will be replicated. 
• Open the Studio302, click the databases icon. 

 

 
Figure 4.7. Creating databases 
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• Select New and create a database with the name of configuration that will be replicated 
(E.g.: PPH). 

 

 
Figure 4.8. Creating databases 

 
• Click OK and a message confirming that the operation succeeded will appear. 

 

 
Figure 4.9. Creating databases 

 
• Click OK. The database is created. 

 

 
Figure 4.10. Database Created 
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c) Unpack the configuration to be replicated in the created Database. 
 

• With Studio302 opened in the Database created (Ex: PPH), click the Unpack icon. 
 

 
Figure 4.11. Unpack the database created 

 
• In the Unpack window, click Browse and select the configuration file (.tgz) saved on the 

computer, which will be replicated (E.g.: PPH.tgz). 
 

 
Figure 4.12. Select the database file 
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• After selecting the file, just click Unpack, wait until the operation is complete, and click OK. 
 

          
Figure 4.13. Unpack the database 

 
• In the sequence, an Unpack record will appear that will confirm the successful operation. 

 

 
Figure 4.14. Confirmation of the database Unpack 

 
d) Create the templates of Database that will be replicated. 

 
• After creating the database and unpacking the configuration, it is necessary to create a 

template for this configuration. 
• In Studio302 click Tools in the toolbar and then Create Database Templates. 

 

 
Figure 4.15. Creation of the database template 

 
• Click Start and wait until the templates are created. 
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Figure 4.16. Starting the creation of the database template 

 
• Then click Next, select the directory where the templates will be saved on the computer 

and click OK. In the example below it will be saved in the Documents folder. 
 

 
Figure 4.17. Selecting the database template folder 

 
• After that, just click OK again, and then, Close. The templates have already been created. 

 

        
Figure 4.18. Database template created 
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e) Creation of new Databases in the generated templates. 
 

• After creating the templates, go to the directory where they were saved and note that there 
are three folders: LogicView, Network, and Syscon. 

 

 
Figure 4.19.Templates folders 

 
• Within each folder there is a CSV file that must be modified according to the new 

databases defined by the user. 
 

LogicView spreadsheet: 
• Inside the LogicView folder, open the generated spreadsheet (CSV file) and notice that 

there are standard tags of the area which the templates were generated from. 
 

 
Figure 4.20. LogicView spreadsheet 
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• To create identical configurations, just create new columns with the names of the desired databases 
and copy the information from the DefaultTag tab to them. 
 

 
Figure 4.21. LogicView spreadsheet 

 
• Save the LogicView spreadsheet. It is ready for replication. 
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Network spreadsheet: 
• Within the Network folder there is a Network spreadsheet (CSV file) that refers to the IPs 

configuration for System302 ServerManager. Open the spreadsheet and fill the file with 
the desired IPs for each database as shown in the following figure.  

 

 
Figure 4.22. Network spreadsheet 

 
• Note that the Router's IP information is for when RTU mode is enabled. If you are not using 

RTU mode, there is no need to fill in this parameter. 
• Save the Network spreadsheet and it is ready for replication. 

 
Syscon spreadsheet: 
• For Syscon, you must perform the same steps as for LogicView. 
• Inside the Syscon folder, open the generated spreadsheet (CSV file) and notice that there 

are standard tags of the area which the templates were generated from. 
 

 
Figure 4.23. Syscon spreadsheet 

 
• To create identical configurations, just create new columns with the names of the desired 

databases and copy the information from the Tag tab to them. 
 

 
Figure 4.24. Syscon spreadsheet 

 
• Save the Syscon spreadsheet. It is ready for replication. 
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f) Replicating databases 
• Done successfully all the steps above, now just replicate the databases. In Studio302 click 

Tools in the toolbar and select Replicate Database Templates. 
 

 
Figure 4.25. Replicating databases 

 
• Click Validate and choose the directory where the templates were created. In this example 

it was saved in the Documents folder. 
 

 
Figure 4.26. Selecting database to be replicated 

 
• Wait for the information validation and then click Replicate. 

 

 
Figure 4.27. Replicating databases 
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• Wait for the replication process to finish, click OK and Close. 
 

       
Figure 4.28. Completion of the database replication process 

 
• Open the databases window to check the replicated databases. 

 

 
Figura 4.29. Replicated databases 

 
 

Areas 
 
Click the Areas icon in the topology tree to open the Area dialog box. The Areas dialog box will 
show all the configurations imported from the Syscon files to the Database. 
 

 The file is located in the local machine. 

 The file is located in the local machine and it is being edited. 

 The file is located in the server machine. 

 The file is located in the server machine and it is being edited. 

 The file is located in the server machine and it is being edited by another user. 

 

The project configuration created using a previous SYSTEM302 version must be 
upgraded to SYSTEM302 version 7.2.x or higher. Right-click the area icon and 
select the option Upgrade. 

 

The file located in the server machine contains the most recent alterations for the 
configuration file. Right-click the area icon and select the option Update to update 
the project configuration. 

 
Right-click the area icon and click Multiuser Details to open the Multi User Details dialog box. This 
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dialog box indicates the status of the configuration file, whether it is being edited in the local 
machine or locked for edition by another user, for example. 
Creating an Area 
 
In the Areas dialog box, right-click the dialog box and click New Area. 
 
Studio302 will launch Syscon and open the dialog box that lists the templates available for each 
linking device. Select the desired template and click Ok. Type the name of the strategy configuration 
and click Ok to conclude. 
 
 
Creating a HART Area 
 
In the Areas dialog box, right-click the dialog box and click New HART Area. 
 
Studio302 will launch the FDT HART tool. In the dialog box, type the name of the topology and click 
Ok. The Topology window will open for edition. 
 
 
Opening the Area in View Mode 
 

ATTENTION 

Right-click the area icon and click Update to update the local information about the configuration 
project before opening the file. This option is only available after the area had been 
commissioned. 

 
Right-click the area icon, in the Areas dialog box, and click View. Studio302 will launch Syscon 
and open the configuration file corresponding to the selected area in View Mode. 
 
If the configuration file is being edited in other machine, the user will not be able to alter or edit this 
configuration. On the other hand, if the file is not being edited, click the Edit Mode button in Syscon 
to switch modes and alter the configuration file. 
 
 
Editing the Area 
 

ATTENTION 

Right-click the area icon and click Update to update the local information about the configuration 
project before editing the file. This option is only available after the area had been commissioned. 

 
Right-click the area icon in the Areas dialog box and click Edit Area. Studio302 will launch Syscon 
and open the configuration file corresponding to the selected area. 
 
Refer to the Syscon User’s Manual for details on how to edit the configuration. 
 
 
Exporting an Area for Standalone Mode 
 
When you export an area to the Standalone mode, the area is removed from the database and the 
configuration files related to the area are saved in a target directory. 
 
Right-click the area icon in the Areas dialog box and click Export for Standalone. The Browse for 
Folder dialog box will open. Select the path to the directory where the configuration files will be 
exported. Click Ok to conclude. 
 
 
Removing an Area 
 
To remove an area from the database, right-click the area icon in the Areas dialog box and click 
Remove Area. 
It is only possible to remove an area created in a local configuration file, that is, a file stored in the 
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local machine. 
 

NOTE 

If the Syscon application is being executed, it will be necessary to close Syscon before 
removing the area. 

 
 
Replacing an Area 
 
To replace an area in the database, right-click the area icon in the Areas dialog box and click 
Replace Area. The Replace dialog box will open. Type the path to the new area or click the 
Browse button to locate the *.ffp file that contains the new area. 
 

 
Figure 4.30. Replacing an Area 

 
Click Ok to conclude. Studio302 will automatically launch Syscon to import the new area. 
 
 
Searching Areas 
 
To search an area by name, type its name on Search field and click Search by Name. 
 

 
Figure 4.31. Searching Areas 
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HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 

Control Modules 
 
To open the list of all control modules in the Database, expand the icon Applications and click 
Control Modules in the topology tree. 
 
The Control Modules dialog box will open. This dialog box lists the control modules related to the 
configurations created using Syscon, and then imported to the current Database. 
 

 The file containing the control module is located in the local machine. 

 
The file containing the control module is located in the local machine and it is 
being edited. 

 The file containing the control module is located in the server machine. 

 
The file containing the control module is located in the server machine and it is 
being edited. 

 
The file containing the control module is located in the server machine and it is 
being edited by another user. 

 
Right-click the control module icon and click Edit control module to open the corresponding 
configuration in Syscon and edit the Strategy window. 
 
If the configuration file is being edited in other machine, the user will not be able to alter or edit this 
configuration. Right-click the control module icon and click View to open Syscon in View mode and 
visualize the Strategy window. 
 
 
Searching Control Modules 
 
To search the name of the control module, select the option Control Module at the bottom of the 
Control Modules dialog box, type the name of the control module and click Search by Control 
Module. 
 
To search the name of the area, select the option Area at the bottom of the Control Modules dialog 
box, type the name of the area and click Search by Area. 
 

HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 
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Figure 4.32. Searching Control Modules 

 
 
Advanced Search 
 
Click Advanced Search at the bottom of the Control Modules dialog box. Use the Advanced 
Search dialog box to find the items that match the two criteria. 
 

 
Figure 4.33. Advanced Search 

 
Type the word to be searched on the text box, click the criteria icon to select it and click the button 
Add <Value>. See the example below: 
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Figure 4.34. Defining Search Criteria 

 
Repeat the steps above to add other criteria. 
 
To delete the value from one criterion, right-click the value and click the option Delete. To delete all 
values from the Advanced Search dialog box, right-click the dialog box area and click the option 
Delete All. 
 
 

Logics 
 
Expand the icon Applications and click Logics in the topology tree to open the list of all logics in 
the Database. 
 
The Logics dialog box will open. Each control logic is related to an Area, indicated in the Area 
column. The Type column indicates whether the configuration is a logic configuration or a logic 
template. 
 

 The file containing the control logic is located in the local machine. 

 
The file containing the control logic is located in the local machine and it is being 
edited. 

 The file containing the control logic is located in the server machine. 

 
The file containing the control logic is located in the server machine and it is being 
edited. 

 
The file containing the control logic is located in the server machine and it is being 
edited by another user. 

 

The file located in the server machine contains the most recent alterations for the 
control logic. Right-click the logic icon and select the option Update to update the 
logic configuration file. 

 
Right-click the logic icon and click Multiuser Details to open the Details dialog box. This dialog box 
indicates the status of the logic configuration file, whether it is being edited in the local machine or 
locked for edition by another user, for example. 
 
At the bottom of the Logics dialog box, mark the option Logic to list all logic configurations, and 
mark the option Logic Template to list all templates. If one of the options is unmarked, the 
corresponding type of logic will not be displayed on the Logics dialog box. 
 
 
Viewing and Editing the Control Logic 
 
The Database Manager manages the alterations made to the logic configuration file. Using 
Studio302 in multi-user mode, it is necessary to commit the alterations after editing the logic. 
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If the logic is not being edited by any user, the option Edit Logic will be available when right-clicking 
the logic icon. LogicView for FFB will open the corresponding configuration to edit the control logic. 
Refer to the LogicView for FFB Manual for details on how to edit the logic. 
 

ATTENTION 

Right-click the logic icon and click Update Logic to update the local information related to the 
logic before editing the logic configuration file. This option is only available after the area/logic 
has been commissioned. 

 
After you finished editing the logic, right-click the logic icon and click the option Commit Logic. The 
alterations will be saved to the Database Manager and other users will be able to edit the logic 
configuration. 
 
When the logic configuration is being edited by another user, right-click the logic icon and click View 
Logic to open the configuration file on View Mode using LogicView for FFB. 
 
 
Defining Parameters 
 
Right-click the logic icon and click Define Parameters. Studio302 will automatically launch Syscon 
and open the FFB Parameters Definition dialog box. 
 
Edit the parameters, if necessary, and click Ok to return to the Studio302. 
 
Refer to the Syscon User’s Manual for details on how to edit the parameters. 
 
 
Creating Logic Templates 
 
To create a logic template, right-click the Logics dialog box and click the option New Logic 
Template. Using LogicView for FFB, type the tag for the new logic configuration, click Ok and edit 
the logic template. 
 
Refer to the LogicView for FFB User’s Manual for details on how to edit the logic. 
 
Close LogicView for FFB and return to Studio302. The new logic template is displayed on the 
Logics dialog box. 
 
 
Searching Logic Blocks 
 
Right-click the logic icon and click Search Logic Block. The Logic Block Search dialog box will 
open. Double-click the icon corresponding to the logic where the block is located to open and edit 
the strategy configuration. 
 
To search the location, type the name on the Search text box and click the button Search. 
 

HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
 
Searching Logics 
 
To search the name of the logic, select the option Logic at the bottom of the Logics dialog box, 
type the name of the logic and click Search by Name. The logic templates can also be searched 
selecting the Logic Template option. 
 
To search the name of the area, select the option Area at the bottom of the Logics dialog box, type 
the name of the area and click Search by Area. 
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Figure 4.35. Searching Logics 

 
HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
 
Advanced Search 
 
Click Advanced Search at the bottom of the Logics dialog box. Use the Advanced Search dialog 
box to find the items that match the two criteria. 
 

 
Figure 4.36. Advanced Search 

 
Type the word to be searched on the text box, click the criteria icon to select it and click the button 
Add <Value>. See the example below: 
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Figure 4.37. Defining Search Criteria 

 
Repeat the steps above to add other criteria. 
 
To delete the value from one criterion, right-click the value and click the option Delete. To delete all 
values from the Advanced Search dialog box, right-click the dialog box area and click the option 
Delete All. 
 
 

Stations 
 
To open the list of all workstations connected to the same database, expand the icon Network 
Devices and click Stations in the topology tree. The Network Devices - Stations dialog box 
opens. 
 

 
Figure 4.38. Stations 

 
This dialog box indicates the name of the workstations, IP addresses, the workstation role and 
detailed descriptions. In a multi-user system, a workstation can be classified in two types: Client or 
Client-Server. There can only be one Client-Server workstation and one or many Client stations in a 
multi-user system. 
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The Client-Server workstation is not connected to the multi-user system. 

 
The Client-Server workstation is connected to the multi-user system. 

 

The Client workstation is not connected to the multi-user system. This status is 
usually indicated right after the workstation is added to the multi-user system, 
using the Network Devices - Stations dialog box. 

 
The Client workstation is connected to the multi-user system. 

 

The Client workstation is not publishing its active status in the multi-user system. 
This may occur because the communication between Client workstation and the 
Client-Server workstation is interrupted. 

 
Right-click the workstation icon and click the option Multiuser information to open the dialog box 
that indicates which areas and logics are being edited in the selected workstation. 
 

 
Figure 4.39. Multiuser information 

 
 
Editing Station Information 
 
On the Description column, click Edit to include information related to the workstation, such as the 
workstation role and a brief description. If the information has already been included for the 
workstation, the Description column will indicate the option Details. 
 
Clicking Edit or Details, the Network Devices – Stations Information dialog box opens. 
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Figure 4.40. Station Description 

 
On the Role box, select the role that the workstation represents on the current database. On the 
Description box, type a brief description of the workstation. 
 
Click Update to confirm the alterations and return to the Network Devices – Stations dialog box. 
 
 
Adding Stations 
 
On the Network Devices – Stations dialog box, click Add to include a workstation to the database. 
The New Station dialog box opens. 
 

 
Figure 4.41. Adding a Station 

 
On the IP box, type the IP address of the new workstation and click Validate. If the IP address is 
correct, a green check mark will indicate the workstation was located. 
 

 
Figure 4.42. New Station 

 
On the Role box, select the role that the workstation represents on the current database. On the 
Description box, type a brief description of the workstation. 
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Click Save to conclude and return to the Network Devices – Stations dialog box. 
 
 
Multiuser Information 
 
Right-click the workstation icon and click the option Multiuser information to open the dialog box 
that indicates which areas and logics are being edited in the selected workstation. 
 

 
Figure 4.43. Multiuser information 

 
This dialog box indicates the names of the areas or logics in Edit mode, and the date and time of 
the last access. 
 
Click the Refresh button to update the information on the dialog box. Click Close to return to the 
Network Devices – Stations dialog box. 
 
 
Generating Reports 
 
On the Network Devices – Stations dialog box, click Report to generate a report listing all 
workstations connected to the database, and the information related to each workstation, such as 
the IP address and role, and also the physical workstation specification, for example, PC processor 
and RAM memory. 
 

 
Figure 4.44. Reports 

 

On the Reports dialog box, click  to print the Stations report. Or click  to export the report to 
a PDF file. 
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Controllers 
 
The Network Devices – Controllers dialog box lists the bridges and controllers from all areas 
created in the current Database. 
 
To open this dialog box, expand the icon Network Devices and click Controllers in the topology 
tree. 
 

 
Figure 4.45. Controllers 

 
 
Configuring the Controller 
 
On the Network Devices – Controllers dialog box, right-click the controller icon and click the option 
Configuration. 
 
Syscon will open the configuration that contains the selected controller. Refer to the Syscon Help 
for details on configuring a controller. 
 
 
Commissioning the Controller 
 
On the Network Devices – Controllers dialog box, right-click the controller icon and select the 
option Commission. Syscon will open the configuration that contains the selected controller. 
 
In the Commission dialog box, click the button to select the controller ID. 
 
The Device Selection dialog box will open. Select the icon of the controller ID and click Ok to 
conclude. 
 
Refer to the Syscon Manual for details on commissioning a controller. 
 
 
Decommissioning the Controller 
 
You can remove the controller from the process control after the controller has been commissioned. 
Right-click the icon of the controller to be decommissioned and select the option Decommission. 
 
Syscon will be executed, and the controller will be removed from the process control. 
 
Refer to the Syscon Manual for details on decommissioning a controller. 
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Downloading the Controller 
 
You can download the controller configuration right-clicking the controller icon and selecting the 
option Download. 
 
The download is executed using Syscon. Refer to the Syscon Help or the Syscon User's Manual 
for details on downloading the configuration to the controller. 
 
 
Managing Controllers 
 
Using the AssetView pages, you can manage the controller’s maintenances and diagnostics. Right-
click the controller icon and select the desired page. 
 
Note that: 

• The Configuration, Calibration, Diagnostic, Identification, Maintenance, Monitoring, Display 
or DeviceView pages will be available in the controller's menu only if AssetView is installed 
and the controller has already been commissioned. 

 
• The SQL Server must have been started and should be running. 

 
• The controller must have been registered in the AssetView database, using the 

AssetServer. 
 
Refer to the AssetView User's Manual for details on registering controllers. 
 
 
Searching Controllers 
 
To search the controller: 
 

1. Select one of the filter options: Device Tag, Device ID, IP, Status, Commissioned, Model 
Name, or Area. 

2. Type the word related to the controller to be searched. 
3. Click the button Search. 

 
HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
 
Advanced Search 
 
Click Advanced Search at the bottom of the Controllers dialog box. Use the Advanced Search 
dialog box to find the items that match two or more criteria simultaneously. 
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Figure 4.46. Advanced Search 

 
Type the word to be searched on the text box, click the criteria icon to select it and click the button 
Add <Value>. See the example below: 
 

 
Figure 4.47. Defining Search Criteria 

 
Repeat the steps above to add other criteria. 
 
To delete the value from one criterion, right-click the value and click the option Delete. To delete all 
values from the Advanced Search dialog box, right-click the dialog box area and click the option 
Delete All. 
 
 

I/O Points 
 
List of I/O Points 
 
To open the list of all devices in the Database and the configured I/O points, expand the icon 
Network Devices > I/O Points and click Net I/O in the topology tree. The Studio302 I/O window 
will open. 
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Figure 4.48. Net I/O Window 

 
On the Studio302 I/O window, mark the option Show I/O user tag to list the points according to the 
tag defined by the user in Syscon. 
 
Besides displaying details about I/O Points, such as their mode, device tag and network channel, 
you can also view their mapping offset. Right-click the I/O Point icon at the I/O Tag column and click 
Details. 
 
 
I/O Points Details 
 
On the Studio302 I/O window, right-click the I/O Point icon on the I/O Tag column and click Details. 
The I/O points details dialog box opens. 
 
For analog I/O points, this dialog box indicates the memory offset and the scale defined for the 
selected I/O Point, using the Mapping Tool application. 
 
For discrete I/O points, this dialog box indicates the memory offset and the data bit offset for the 
selected I/O Point. 
 
It is not possible to edit I/O point information in the I/O points details dialog box. To edit the I/O 
point, open the Area that contains the corresponding device in Syscon. Refer to Syscon Manual 
for details. 
 
 
I/O Points Supervision Mode 
 
On the Studio302 I/O window, mark the option Supervision to launch System302 ServerManager 
and start monitoring the values of the I/O points, which are indicated in the Value column. 
 
The I/O User Tag column indicates the quality and the status of the point during supervision. 
 
To open the Symbology window that details the point supervision indication, go to the View menu 
and click the option NET I/O symbology window. References for the point quality and status are 
indicated at the bottom of the Studio302 - I/O window. 
 
Points signalized in red may indicate there is a problem in the OPC communication. Points 
signalized in green indicate the communication is good and the point value is being read from the 
device. 
 
It is necessary to export tags using Syscon to guarantee the OPC communication. 
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Searching I/O Points 
 
To search the I/O point, first select one of the filter options: I/O Tag, Mode, Block, Device or 
Network. 
 
Type the word related to the I/O Point to be searched and click Search. Points related to your 
search will be displayed at the I/O points table. 
 

HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
 
Customizing the Studio302 I/O Window 
 
You can customize the Studio302 I/O window and select the columns that will be displayed. Right-
click the window area and click the option Customize View. 
 
The dialog box will open. Select the desired columns and click Apply. 
 

 
Figure 4.49. Customizing the Studio302 I/O Window 

 
 
Saving the Log File 
 
To save the information related to the I/O Points supervision, right-click the Studio302 I/O window 
area and click the option Save Log File. 
 
 

Field Devices 
 
Detecting New Devices 
 
The Device Detection Service alerts you about new devices being added to the plant, when the 
plant is already operating. 
 
You can initialize this service manually, in Settings > Communication, clicking the Start button on 
the Services tab in the Communication Settings dialog box or by clicking the Online/Offline 

Communication button  on the main toolbar. 
 
When a new device is detected, the Studio302 icon in the taskbar blinks and a dialog box opens 
informing the user about the new device detected. See the example in the figure below: 
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Figure 4.50. Detecting Devices 

 
IMPORTANT 

If a device is replaced in the plant in the maintenance procedure, this device will be detected by 
this service and can only be commissioned if its logical representation exists in a configuration 
included in the current Database of the Studio302. 
That is, a device – virtual or not commissioned – should exist in the Syscon configuration that 
represents the plant process control, to be associated to the new physical instrument detected. 

 
To commission the new device, click Yes and Syscon will be executed, automatically opening the 
project that contains the bridge where the device was detected. 
 
If the user clicks No, the device will appear in the list of new devices detected in Studio302, waiting 

for the commissioning. To open the New Device window, click the button  on the toolbar. 
 
To commission the device from the New Device Detect window, right-click its icon and click 
Commission. Syscon will be executed. Refer to the Syscon User’s Manual for details on 
commissioning a device. 
 
 
Field Device List 
 
To open the list of all devices in the Database, expand the icon Network Devices and click Field 
Devices in the topology tree. 
 
The Field Devices List dialog box will open. You can execute several procedures, such as opening 
the device's pages with AssetView, commissioning and decommissioning a device, or downloading 
the configuration using Syscon. 
 
The Field Devices List dialog box displays the information related to the devices in the current 
Database, such as the device ID, the tag of the fieldbus channel connected to the device, the 
number of the port that connects the bridge to the fieldbus and the device status in the plant 
configuration. 
 
Click Refresh at the bottom of the Field Devices List dialog box to read the information of all 
devices from every configured OPC Server. 
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 The file containing the device is located in the local machine. 

 The file containing the device is located in the local machine and it is being edited. 

 The file containing the device is located in the server machine. 

 
The file containing the device is located in the server machine and it is being 
edited. 

 
The file containing the device is located in the server machine and it is being edited 
by another user. 

 
 
Managing Devices 
 
Using the AssetView pages, you can manage the device's maintenances and diagnostics. Right-
click the device icon and click the corresponding device page. 
 
Note that: 

• The Configuration, Calibration, Diagnostic, Identification, Maintenance, Monitoring, Display 
or DeviceView pages will be available in the device's menu only if AssetView is installed 
and the device has already been commissioned. 

• The SQL Server must have been started and should be running. 
• The device must have been registered in the AssetView database, using the AssetServer. 

 
Refer to the AssetView User's Manual for details on registering devices. 
 
 
Searching Devices 
 
To search the device, first select one of the filter options: Device Tag, Device ID, Protocol, Bridge, 
Port, Status, Commissioned, Network, Address, or Area. 
 
Type the word related to the device to be searched and click Search. 
 

 
Figure 4.51. Searching Devices 

 
HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 
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Advanced Search 
 
Click Advanced Search at the bottom of the Field Devices List dialog box. Use the Advanced 
Search dialog box to find the items that match two or more criteria simultaneously. 
 

 
Figure 4.52. Advanced Search 

 
Type the word to be searched on the text box, click the criteria icon to select it and click the button 
Add <Value>. See the example below: 
 

 
Figure 4.53. Defining Search Criteria 

 
Repeat the steps above to add other criteria. 
 
To delete the value from one criterion, right-click the value and click the option Delete. To delete all 
values from the Advanced Search dialog box, right-click the dialog box area and click the option 
Delete All. 
 
 
Fieldbus Devices 
 
Configuring a Fieldbus Device 
Right-click the device icon and click Configuration to access the information on the device 
configuration. 
 
Syscon will open the configuration that contains the selected device. Refer to the Syscon User's 
Manual for details on configuring a device. 
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Commissioning a Device 
Right-click the device icon and click Commission to commission a device. Syscon will open the 
configuration that contains the selected device. 
 

In the Commission dialog box, click the button  to select the device ID. The Device Selection 
dialog box will open. Select the icon of the device ID and click Ok to conclude. 
 
Refer to the Syscon User's Manual for details on commissioning a device. 
 
 
Decommissioning a Device 
You can remove a device from the process control after the device has been commissioned. Right-
click the icon of the device to be decommissioned and click Decommission. 
 
Syscon will be executed, and the device will be removed from the process control. Refer to the 
Syscon User's Manual for details on decommissioning a device. 
 
 
Device Download 
You can download the device configuration right-clicking the device icon and clicking Download. 
 
The download is executed using Syscon. Refer to the Syscon Help or the Syscon User's Manual 
for details on downloading the configuration to the device. 
 
 
HART Devices 
 
Configuring a HART Device 
Right-click the HART device icon and click the option Open DTM to open the area that contains the 
selected device on the FDT HART Configurator tool. 
 
Refer to the AssetView FDT HART manual for details on configuring the HART device. 
 
 
Profibus Devices 
 
Configuring a Profibus Device 
Open the Field Devices List dialog box, right-click the Profibus device icon and click the option 
Cyclic Configuration to open Syscon and edit the configuration file that contains the selected 
device. Refer to the Syscon User's Manual for details on configuring a Profibus device. 
 
Right-click the Profibus device icon and click the option Acyclic Configuration to access the 
information on the device configuration. The ProfibusView application will open the device dialog 
box. Refer to the ProfibusView User's Manual for details on configuring the Profibus device. 
 
Right-click the Profibus device icon and click Open DTM to open the Smar AssetView FDT 
application. This application allows you to parameterize blocks from the device, in online or offline 
mode. Refer to the AssetView FDT User's Manual for details. 
 
 
Detecting a Profibus Device 
When a new Profibus device is connected to the plant, it is necessary to configure the address. 
 

Click the button  on the Applications toolbar to open the ProfibusView dialog box: 
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Figure 4.54. Detecting Profibus Devices 

 
Select the device manufacturer and the type of the device. Type the master IP address and the 
slave address. Click Ok to conclude. 
 
It will be necessary to open the configuration file and add the device to the plant strategy. 
 
 
DeviceNet, AS-i and Modbus Devices 
 
Configuring a DeviceNet, AS-i or Modbus Device 
Open the Field Devices List dialog box, right-click the device icon and click the option 
Configuration to open Syscon and edit the configuration file that contains the selected device. 
 
Refer to the Syscon User's Manual for details on configuring a DeviceNet, AS-i or Modbus device. 
 
 

Configuration Samples 
 
When you run Studio302 for the first time, the Samples Screen opens and you can select a 
configuration file sample to be opened. 
 
The Studio302 Samples are created by Smar engineers to provide standard examples of plant 
control applications. 
 

 
Figure 4.55. Studio302 Samples Screen 

 
Click the link Configuration Files to select a configuration sample. The Unpack Files dialog box 
will open. 
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Figure 4.56. Selecting a Sample File 

 
In the area Select a file to unpack, click Browse to locate the sample file. During the SYSTEM302 
installation, the samples files created by Smar are copied to the default installation folder: 
C:\Program Files\Smar\Studio302\Samples\Configurations\. 
 

 
Figure 4.57. Unpacking a Sample File 

 
Select the file icon and click Open to return to the Unpack dialog box. 
 
In the area Select the temporary path to extract the files, click Browse to select a temporary 
folder that will be used during the unpack process. 
 
Click Unpack to execute the procedure and unpack the sample file to the current Studio302 
database. The configuration and support files will be extracted to the current database. 
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Section 5 
 

5.1 

PROCESS EQUIPMENT DATABASE 
 
Click the Process Equipment Database icon on the topology tree to open the Process Equipment 
Database window. 
 
All information about the instruments in the plant will be stored in a Database. A node in the 
database will represent an instrument. This node gathers specific attributes of the instrument, and 
common links and attributes inherit from the category. 
 

 
Figure 5.1. Process Equipment Database 

 
Specific instrument attributes includes links to documentation files, instrument images, Web pages, 
process visualization and supervision screens, and executable files. 
 
 

Importing the Process Equipment Database 
 
To import the information from the Process Equipment Database of another machine: 
 

1. Go to the File menu, select the option Import and then click Process Equipment 
Database. 

2. The Import Process Equipment Database dialog box will open. 

3. Click Browse to select the folder where the compacted file is located. 

4. Select the file icon and click Open. 

5. Studio302 will verify the information in the compacted file, comparing it to the information in 
the current Process Equipment Database. The Import Process Equipment Database 
dialog box will indicate if there are any conflicts with the parameters. 
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Figure 5.2. Importing the Process Equipment Database 

 
6. If there is a conflict with the tags of the nodes and types, you will have to edit the tags: 

i. Select the icon of the tag; 
ii. Type the new tag on the text box at the bottom of the dialog box; 
iii. Click Update. 

7. Click Ok to conclude and import the new nodes to the Process Equipment Database. 
 
 

Exporting the Process Equipment Database 
 
You can compact the information from the Process Equipment Database in one single file and 
send this file to another machine. 
 
On the File menu, click Export and then click Process Equipment Database. The Export Process 
Equipment Database dialog box will open. 
 

 
Figure 5.3. Exporting the Process Equipment Database 

 
Browse the directories to select the folder to save the file, and type the name for the compacted file. 
The file extension will be "*.tgz". Click Save to compact the information and save the file. 
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Saving an equipment template 
 
On the Process Equipment Database window, right-click the icon of the equipment and select the 
option Save as Template. The dialog box will open. 
 

 
Figure 5.4. Saving an equipment template 

 
Type the name for the template file but do not type a file extension. Click Ok and a message box 
will open indicating the location to the template file. The default path for equipment template files is 
C:\Program Files\Smar\Studio302\Bin\Templates. 
 
Click Ok to conclude. 
 
 

Importing an equipment template 
 
On the Process Equipment Database window, right-click the Process Equipment Database icon, 
or the icon of the parent equipment where the new equipment will be created, and select the option 
Import Template. 
 
The Import Template File dialog box will open. Select the icon of the desired template file and click 
Open. Remember that the default path for equipment template files is C:\Program 
Files\Smar\Studio302\Bin\Templates. 
 

 
Figure 5.5. Importing an equipment template 

 
A message box will open informing that the procedure was successful. Click Ok to conclude. 
 

IMPORTANT 

It is not possible to import the same template file again, in the Process Equipment Database. 
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Searching similar equipment 
 
Similar equipment is instance of an equipment or special item created as a copy from another 
equipment in the Process Equipment Database. Similar equipment is displayed in green in the 
Process Equipment Database. See the example below: 
 

 
Figure 5.6. Similar Equipment 

 
To locate all equipment similar to a specific equipment or special item, right-click the icon of the 
instance of an equipment or special item and select Find Similar Equipments. 
 
The Similar Equipments dialog box will list the parent equipment that contain instances similar to 
the selected equipment. 
 

 
Figure 5.7. Locating Similar Equipment 

 
From the Similar Equipments dialog box, right-click an item and click Delete the Similar 
Equipment to remove the occurrences of similar equipment. See the following section Removing 
an Equipment. 
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Right-click the icon of the equipment and click Save as Template to create the xml template file 
based on the selected similar equipment. 
 
 

Equipment 
 
Creating an Equipment 
 
On the Process Equipment Database window, right-click the Process Equipment Database icon 
and select the option New Equipment. The New Equipment dialog box will open. 
 

 
Figure 5.8. Creating Equipment 

 
Type the name in Functional Name and a brief description for the equipment. Click the button 
Customize to open the Customize Aspects dialog box and edit the aspects for the new equipment. 
See section Customizing Aspects for details. 
 
Click Ok to conclude. 
 
 
Creating Aspects for the Equipment 
 
On the Process Equipment Database window, right-click the equipment icon and click New 
Equipment. The New Equipment dialog box will open. 
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Figure 5.9. Creating Types 

 
Type the name in Functional Name and a brief description for the equipment type. 
 
Mark the option Inherit the aspects of the parent equipment to apply the aspects defined for the 
Parent node to the equipment being created. If this option is not marked, the aspects will not be 
applied to the new equipment. 
 
Click the button Customize to edit the aspects for the new equipment. See section Customizing 
Aspects for details.  
 
Click Ok to conclude. 
 
 
Replicating Equipment 
 
To create a new instance of an equipment or special item, right-click the icon and click Copy from 
the popup menu. 
 
Then, right-click the other equipment or special item where the new instance will be created and 
select the option: 
 

• Paste as reference: all information and aspects will be copied to the new instance of the 
equipment or special item, and any changes made to the new instance will be applied to 
the original equipment, and vice-versa. 

• Create new equipment from: all information and aspects will be copied to the new 
instance of the equipment or special item, but changes made to the new instance will not 
affect the original equipment, and the changes made to the original equipment will not be 
applied to the new instance created. 

 
 
Searching Equipment 
 
Right-click an Equipment icon and click Search Equipment. The Search Equipment dialog box 
will open. 
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Figure 5.10. Searching Nodes 

 
Select one of the filter options: Action Aspect, Equipment, Value, or Database Name. Type the word 
related to the node to be searched and click Search. 
 

HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
Removing an Equipment 
 
To remove equipment from the Process Equipment Database, right-click the equipment icon, in 
the Process Equipment Database dialog box, and click Delete Equipment. 
 
A message box will open to confirm the operation. Click Yes to delete the equipment and the 
aspects related to the equipment will be removed from the Process Equipment Database. Or click 
No and the equipment will not be deleted. 
 
If there is one "similar equipment", that is, an instance of an equipment or special item created as a 
copy from another equipment, in the Process Equipment Database, a dialog box will open to 
confirm the operation: 
 

• Select Delete this Similar Equipment only from this Equipment Parent to remove only 
the selected item from the Process Equipment Database. 

• Select Delete this Similar Equipment from all Equipments to remove all references to the 
selected item from the Process Equipment Database. 

 
Removing Inherited Aspects 
 
To remove inherited aspects from the equipment, right-click the equipment icon and click Remove 
Inherit. The aspects inhered from the Parent node will be deleted and new aspects created for the 
Parent node will no longer be inhered by the sub-node. 
 
Only the aspects from the sub-nodes will be deleted. The aspects from the Parent node will not be 
affected. 
 
 

Special Items 
 
A special item can be an instrument, a control module or an area, that is part of the configuration file 
managed by Studio302. 
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Creating Special Items 
 
On the Process Equipment Database window, right-click the Process Equipment Database icon 
and click New Special Item. The New Special Item dialog box will open. 
 

 
Figure 5.11. Creating Special Items 

Select the category of the special item: Areas, Control Module, Field Devices, Logics or 
Controllers. Then, select the icon of the tag related to the special item being created. 
 
Type a brief description for the special item. Click the button Customize to edit the aspects for the 
new special item. See section Customizing Aspects for details. 
 
Click Ok to conclude. 
 
 

Aspects 
 
The Aspects window shows details about customized aspects, which are information or actions 
associated to the selected equipment, such as the description, charts, web links, executable files, 
etc. Right-click the icon of the equipment and click View Aspects Window. 
 
 
Creating Aspects 
 
On the Process Equipment Database window, right-click the icon of the equipment and click 
Customize Aspects. The Customize Aspects dialog box will open. Click New. 
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Figure 5.12. Creating Aspects 

 
Select the type of the new Action or Information Aspects. Configure the information related to the 
new aspect. Click Ok to conclude. This process can be repeated as many times as necessary 
without having to close the window. See section Customizing Aspects for details. 
 
 
Editing an Aspect 
 
Click the aspect icon and then Edit. The Customize Aspects dialog box will expand and the 
Update tab will appear. Configure the information related to the aspect. See section Customizing 
Aspects for details. 
 
Click Ok to conclude. 
 
 
Copy and Paste an Aspect 
 
Right-click the aspect you want to copy in the main Process Equipment Database window and 
select Copy Aspect. 
 
Select the equipment icon where the copy of the aspect will be created. Right-click the equipment 
and select Paste Aspect. 
 
 

ATTENTION 

If you want to move an aspect from one equipment to another, right-click the aspect icon and 
select Cut Aspect instead of the option Copy Aspect. Then, right-click the target equipment icon 
and select Paste Aspect. The aspect will be deleted from the original equipment and added to 
the target equipment. 

 
 
Customizing Aspects 
 
Click the button Customize when creating an aspect or in the Aspects window to open the 
Customize Aspects dialog box. 
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Default Aspects 
 
In the Default Aspects box, double-click the default aspect to edit the information. 
 

• F.N.: type the tag for the equipment or special item. 
• Image: click Browse to select an image to represent the equipment or special item. 
• Description: type a brief description for the equipment or special item. 

 

 
Figure 5.13. Default Aspect 

 

Action Aspects 
 
At the Customize Aspects dialog box, select the Action Aspects tab. 
 

• File: Include a link to any type of files related to the aspect, such as user’s manuals, 
technical documentation and pictures. Click the Browse button to locate the file and type 
the name for the new aspect. 

 

 
Figure 5.14. Attaching Files 
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• Executable: Include a link to an executable file related to the aspect. Click the Browse 
button to locate the file and type the name for the new aspect. 

 
Figure 5.15. Attaching Executable Files 

 
• ProcessView: Include a link to ProcessView files related to the aspect, such as process 

mimic screen, alarm screens and trend view screens. Click the Browse button to locate the 
file and type the name for the new aspect. 

 
Figure 5.16. Attaching ProcessView Files 

 
• Web Link: Include a link to a Web page related to the aspect, such as the device 

manufacturer’s pages. Type the URL address and type the name for the new aspect. 
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Figure 5.17. Linking to a Web Page 

 
• OPC Aspect: Include a representation for an OPC tag. The value will be monitored in the 

Process Equipment Database window. This aspect is only available for the Device 
special item. See section Configuring OPC Aspects. 

 
Figure 5.18. OPC Aspects 

 
 

Information Aspects 
 
At the Customize Aspects dialog box, click New and select the Information Aspects tab. 
 

• Input Text: Include a text field for the equipment. Type the name for the new aspect and 
add the information text. 
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Figure 5.19. Input Text 

 
• Multi Options: Include a multiple options text field to list the information related to the 

aspect. Type the name for the new aspect; add each option by typing the option text and 
clicking the Add button. 

 

 
Figure 5.20. Multi Options 

 
To edit an option, select this option and click Edit. Type the new information and press Enter on 
your keyboard. The Selected Option field indicates which is the default option that appears 
selected when the user clicks on this aspect. 
 
 

OPC Aspects 
 
Configuring OPC Aspects 
 
When creating an OPC Aspect on the Customize Aspects dialog box, click New, and then select 
Action Aspects tab. Click OPC Aspect option and then click the Browse button to open the OPC 
Browser dialog box. 
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Figure 5.21. OPC Browser dialog box 

 
Select the OPC server from the list and click Connect to read the list of available parameters from 
the selected server. 
 
Click the block icon on the box on the left side of the dialog box and the list of parameters related to 
this block will be displayed on the box at the right side of the dialog box. 
 
Select the OPC parameter icon and click Ok to return to the Customize Aspects dialog box. 
 
When you click Ok at the Customize Aspects dialog box, the value of the OPC parameter will be 
read from the server and indicated on the Process Equipment Database window. 
 
 
Connecting and disconnecting OPC Aspects 
 
On the Process Equipment Database window, right-click the Process Equipment Database icon 
and select Connect all OPC Aspects. The values of all OPC parameters will be read from the 
server and indicated on the Process Equipment Database window. 
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Figure 5.22. Monitoring OPC Aspects 

 
To monitor only a specific OPC parameter, right-click the corresponding OPC Aspect icon and click 
Connect OPC Aspect. 
 
To stop monitoring the OPC parameters, right-click the Process Equipment Database icon and 
click Disconnect all OPC Aspects. To stop monitoring only a specific OPC parameter, right-click its 
icon and click Disconnect OPC Aspect. 
 
OPC Aspects details 
 
Right-click an OPC Aspect icon and click Details. The OPC Aspect Details dialog box will open. 
 

 
Figure 5.23. OPC Aspect Details dialog box 

 
The OPC Aspect Details dialog box indicates the quality of the communication, the location 
(remote or local) of the project configuration file where the block parameter was created and the 
OLE server selected for the communication. 
 
 

Process Equipment Database Samples 
 
When you run Studio302 for the first time, the Samples Screen opens and you can select a 
Process Equipment Database sample to be opened. 
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The Studio302 Samples are created by Smar Engineers. 
 

 
Figure 5.24. Studio302 Samples Screen 

 
Click the link Process Equipment Database to select a Process Equipment Database sample. 
 
The Import Process Equipment Database dialog box will open. Browse the directories to locate 
the sample file. The default location for samples files is: C:\Program Files\Smar\Studio302\Samples\ 
EquipDatabase\. 
 

 
Figure 5.25. Selecting a Process Equipment Database Samples 

 
Select the file icon and click Ok on the Import Process Equipment Database dialog box. 
 
The Import procedure will be executed and the items from the sample file will be imported to the 
current Process Equipment Database. Click Ok to conclude. 
 
 

ATTENTION 

If there are conflicts between the tags of the nodes and types from the template, and the existent 
tags in the current Process Equipment Database, you will have to edit the tags. See section 
Importing the Process Equipment Database. 

 
 



Section 6 
 

6.1 

USERS AND GROUPS MANAGEMENT 
 
Studio302 incorporates the Group of Users from the Windows Operating System. Windows’ users 
can log to Studio302 using the same login name and password. 
 
The SYSTEM302 default installation does not enable the secure mode for Studio302. To enable the 
secure mode and be able to manage users and groups, click Settings > Security, and click Enable 
Login. 
 
When Studio302 is initialized, the Login dialog box will open: 
 

 
Figure 6.1. User Login 

 
Using the Group Management window in Studio302, the System Administrator can configure the 
access rights and permissions for the other users. 
 
To open the Group Management window, go to the Settings menu, select the option Security and 
then click Group Management. 
 

 
Figure 6.2. Group Management 

 
 

ATTENTION 
The Enable Login option must be enabled first for the Group Management option to become 
available as well. 

 
 
The following window will open: 
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Figure 6.3. Groups and Permissions 

 
 

Editing Group Permission 
 
Select the group icon in the Group Management window and click Edit to configure the access 
rights for the users in that group. 
 
The Group Permission dialog box will open: 
 

 
Figure 6.4. Editing Groups Permissions 

 
To allow the group access to a system functionality, select the feature at the List of Permissions 

and click the button . The selected feature will be added to the Allowed list. 
 
To deny the group access to a system functionality, select the feature at the Allowed list and click 
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the button . The selected feature will be removed from the Allowed list. 
 
Click the button Save to apply the changes to the group and click Close to conclude. 
 

ATTENTION 

You must configure the DCOM properties every time the List of Permissions is altered. Refer to 
the tutorial Configuring the DCOM properties. 

 
 

Searching Groups 
 
To search the name of a group: 
 

1. Select the option Group at the bottom of the Group Management window. 

2. Type the name of the group. 

3. Click the button Search by Group. 
 
To search the permission for any system functionality: 
 

1. Select the option Permission at the bottom of the Group Management window. 

2. Type the name of the system functionality. 

3. Click the button Search by Permission. 
 

HINT 

The wild char '*' (asterisk) can be used to replace one or several characters. The asterisk may be 
placed anywhere in a search string, and the string may include several asterisks. The "?" 
(Question mark) can be also used as a wild char. 

 
 

Multiuser Security 
 
The Multiuser Security dialog box lists the users logged to the Database Manager in a multi-user 
scenario, indicating their IP addresses, status and the Studio302 installation mode. 
 

On the right lower corner of the Studio302 window, double-click the Multiuser Security icon  to 
open the dialog box. 
 

 
Figure 6.5. Multiuser Security 
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The Multiuser Security icon will blink on the Studio302 window if there is a workstation in 
unsecured mode. 
 
 

ATTENTION 

The SQL Server 2014 must be installed on each workstation and the workstations must be using 
the same SQL data communication port. 

 
 
 
 
 
 



Section 7 
 

7.1 

MANAGEMENT TOOLS 
 

Defining the Manufacturer ID 
 
The Manufacturer ID is defined when creating a database. A database can only be created in the 
Client/Server mode, when the Database Manager is being executed. In the Database dialog box, 
select New and then click Browse on the Manufacturer ID box to open the Manufacturer ID dialog 
box. 
 

 
Figure 7.1. Creating a Database 

 
All Manufacturer IDs registered on the FFB Manager are listed on the All tab. The Recently tab 
will list the most recent Manufacturer IDs selected by the user. 
 
Click the icon corresponding to the name of the manufacturer to select it. The profile numbers 
related to the selected Manufacturer ID will be used in the new Database. Click Ok to conclude. 
 

 
Figure 7.2. Defining the Manufacturer ID 
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IMPORTANT 

To register a non-listed Manufacturer ID, please contact a Smar representative and request 
your Manufacturer ID. 

 
 

Pack & Go 
 
Packing Database Files 
 
The Pack procedure in Studio302 includes the project configuration files created in Syscon, 
configuration files created in LogicView, initialization files for these tools, Block Support and 
Device Support files, Studio302 files related to the current Database, configuration files, 
description files and image files of devices used by the Network Configurator tool, initialization files 
for the OPC servers, and ProcessView configuration files consolidated by the ProjectWorX tool. 
 
Those files are grouped in a single compacted file. The compacted file has the extension *.tgz, and 
it is compatible with Winzip and other applications. 
 
This package can be sent and unpacked into another machine. Follow the procedure below to pack 
the Database files: 
 

1. Click the button  on the main toolbar. The Pack & Go dialog box will open. 

 
Figure 7.3. Pack & Go 

 
2. Select the type of files that will be packed: 

• Full: all configuration files (Studio302, Syscon, LogicView, Network Configurator 
and ProcessView) imported to the current database, dependency files and the 
folders related to the Block Support and Device Support will be included in the 
package. 

• Light: all configuration files (Studio302, Syscon, LogicView, Network 
Configurator and ProcessView) imported to the current database will be included 
in the package but only the Block Support and Device Support folders used by the 
configuration files will be included in the package. 

3. Click Create. A dialog box opens and the user selects the path to the compacted file. 
Browse de directories and select the destination folder. 



Management Tools 
 

7.3 

 
Figure 7.4. Selecting the Destination Folder 

 
4. Type the name for the package and click Ok. The procedure to pack all files selected may 

take a few minutes. To cancel this procedure, click Cancel on the Pack & Go dialog box 
and the operation will be aborted. 

5. A message box will appear informing the user if the operation was successful. 

6. Click Ok to conclude. 

 
 
Unpacking Database Files 
 
The Unpack procedure will delete the list of areas in the current database and include the areas 
listed in the compacted file. 
 
Syscon project configuration files where removed areas were created are not deleted from the 
working directory in the local machine, therefore after executing the Unpack procedure you may 
include areas from the previous database to the current one, importing the Syscon configuration 
files where those deleted areas were configured. 
 

IMPORTANT 

To execute the Unpack procedure, the current database name must be the same name used by 
the database from where the files were compacted and the same ManufacturerID must be 
selected. If the database or the ManufacturerID do not exist, it will be necessary to create them 
before executing the Unpack. If the database already exists, make sure it is the current database 
used by Studio302. 
If Studio302 is being executed in Multi-User mode, it will be necessary to remove the files from 
the server database before unpacking the configuration files. Refer to the tutorial Pack & Go 
procedure in Multi-User Mode in this manual for further details about the procedure. 

 
Follow this procedure to unpack the database files: 
 

1. Click the button  on the main toolbar. The Unpack dialog box will open. 
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Figure 7.5. Unpacking Database Files 

 
2. At the Select a file to unpack, click Browse to open the Unpack files dialog box and 

locate the compacted file. Click Ok to return to the Unpack dialog box. 

3. At the Select the temporary path to extract the files, click Browse to open the Extract 
to dialog box and select the directory where the compacted file will be extracted. 

The selected folder will only be used as a temporary folder and will be automatically deleted 
after the Unpack procedure is complete. The files related to the configuration will be 
located in the SYSTEM302 working directory. 

Click Ok to return to the Unpack dialog box. 

4. Click Unpack on the Unpack dialog box to extract the files. If the option List all files is 
selected, a list of all files saved to the destination folder will be displayed at the end of the 
Unpack procedure. 

5. A message box will appear informing the user that the operation was successful. 

6. Click Close to conclude. 

 
Unpack Trace 
 
The Unpack Trace dialog box will open when the Unpack procedure detects inconsistencies in the 
compacted configuration files. 
 
The Trace procedure verifies the following items: 
 

• Configuration files: the Trace procedure checks if the Syscon configuration files were 
locked, pending or outdated when the Pack procedure was executed. 

 
• Logic files: the Trace procedure checks if the ladder logics were locked, pending or 

outdated when the Pack procedure was executed. 
 
• Device Support and Block Support: the Trace procedure checks if there are Device 

Support, Block Support and Capabilities files missing. 
 
Right-click the Unpack Trace dialog box and click Save to save the information to a log file in HTML 
format. 
 
Pack & Go in Multi-User Mode 
 
In a multi-user scenario, there is one station configured as Client/Server and one or more stations 
configured in Client mode. 
  
The Client/Server station has two databases managed by specific applications. The Database 
Manager stores the information in the server machine and manages the project configuration files 
configured by the users in the local machine or in another Client station, using Syscon or 
LogicView, for example. The Database Manager has a list of areas imported in Studio302 and 
controls the alterations made to the projects. This means the information stored in the Database 
Manager always overwrites the information in the database located in the client machines. 
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A Client station has one database installed locally and managed by the Database Client, which 
stores the information related to the configuration files in the client machine, and this information is 
synchronized with the Database Manager in the Client/Server station. The Database Client from 
every Client station reflects the data from the Database Manager and, therefore, the information 
from the Database Manager overwrites data in the Client stations when the Update All procedure 
is executed. 
 

ATTENTION 

When a user is editing an area or logic, that is, the configuration file is in Edit Mode, data in the 
client machine are not overwritten. 

 
Packing Files 
 
The configuration files should be packed in the Client/Server station. 
 
Before packing the files, make sure the information related to the configurations are updated in the 
Database Manager in the Client/Server station. It is also important to assure that areas and logics 
are NOT in Edit Mode. 
  
The Commit procedure sends the information related to a project file to the Database Manager 
and, at the same time, changes the status to View Mode. This procedure must be executed for 
every project file managed by the Database Manager in the Client station where each project 
configuration was most recently updated. 
  
To execute the Commit procedure in the Client stations, using Studio302, open the Areas window 
and for each area in Edit mode, right-click its icon and select the option Commit. Repeat this 
procedure for all logics in the Logics window. 
 

Click the button  on the main toolbar to open the Pack & Go dialog box. Select the type of files 
to be packed and click Create. Select the folder where the compacted file is saved, type the name 
for the file and click Ok. A message box informs the user that the operation is completed. Click Ok 
to conclude. 
 
Unpacking Files 
 
It is recommended to unpack files in the Client/Server station, and assure the Database Manager 
has no information about old configurations in order to prevent conflicts with new areas and logics. 
 

To remove the configurations from the Database Manager, double-click the icon  of the 
Database Manager displayed in Windows taskbar (or right-click the icon and select Show). 
  
On the Database Manager window, right-click the name of the configuration at the column Name 
and select the option Delete, as indicated in the following example. 
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Figure 7.6. Database Manager window 

 
Repeat this procedure to remove all areas and logics from the Database Manager. This procedure 
deletes the configurations from the current database in Studio302. If there are other databases, 
even when the system is not being executed in Multi-User mode, areas and logics from those other 
databases will be affected. 
  
To delete configurations related to other databases, go to the Databases menu, and click the option 
Change Current Database to change the current database in Database Manager. Select the 
desired database and click Change. Click the button  to close the dialog box and return to the 
Database Manager window. The current database in indicated in the status bar at the bottom of the 
Database Manager window. 
 

After removing the configurations, execute the Unpack procedure. Click the button  on the 
main toolbar to open the Unpack dialog box. Select the backup file and click Unpack to unpack the 
configuration files. 
 
Click Close in the Unpack dialog box to conclude. Refer to the topic Unpacking Database Files for 
further details. 
  
After concluding the Unpack procedure, the Update All procedure is automatically executed to 
update the database information in all Client stations. The icon of the areas and logics will indicate 
the Local mode. 
  
Execute the Commit procedure for ALL areas and ALL logics. Using Studio302, open the Areas 
window and for each area in Edit mode, right-click its icon and select the option Commit. Repeat 
this procedure for the logics in the Logics window. 
 

ATTENTION 

From SYSTEM302 version 7.1.3 on, when the Commit procedure is executed in an area for the 
first time, for example, right after the Unpack procedure, FFBs are automatically stored in the 
Database Manager, therefore in this scenario the Commit procedure for logics is executed 
transparently to the user. 

 
Now, new information is stored in the database from the Client/Server station and managed by the 
Database Manager. When a Client station connects to the Database Manager, the information in 
that station is synchronized with the server. 
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License Monitor 
 
The License Monitor window shows the number of licensed devices, Process Equipment Database 
items and blocks according to the user’s software licenses. 
 

ATTENTION 

To check your authorized installed products, run the LicenseView application clicking the button 

 on the Applications toolbar. 
 
 
Click the button License Monitor on the LicenseView window and the following window will 
appear: 
 

 
Figure 7.7. License Monitor window 

 
• The column Licensed shows the number of points (devices, blocks or items) available for 

the registered license key. 

• The column Used shows the number of points (devices, blocks or items) being used in the 
configuration files or the applications. 

• The column Available shows the remaining number of points (devices, blocks or items) 
available for the registered license key. 

 
If the number of Available points is higher than the average limit percentage defined by the user, 
that number will be displayed in orange. Likewise, if number of Available points is higher than the 
low limit percentage defined by the user, that number will be displayed in red. See section Defining 
User's Preferences for further information about defining the limit percentages. 
 
 

Diagnostics 
 

Click  on the main toolbar to open the Diagnostics window and monitor devices with 
maintenance, diagnostic and tracking events, and the status of block links created using Syscon. 
 
 
Devices Summary 
 
The Devices Summary dialog box shows the number of devices with maintenance, diagnostic and 
tracking events. 
 
Right-click the Devices Summary icon on the Diagnostics window and click the option Start 
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Devices Summary to start communicating with AssetView. 
 

 
Figure 7.8. Devices Summary dialog box 

 
• Devices with Diagnostic Events: indicates the number of devices with diagnostic 

event(s). Click this option to open the Diagnostic View page. 
• Devices with Scheduled Maintenances: indicates the number of devices with scheduled 

maintenance(s). Click this option to open the Maintenances Page. 
• Devices with Tracking Events: indicates the number of devices with tracking event(s). 

Click this option to open the Tracking View page. 
 
Click each option to open the respective AssetView web page. 
 
 
Live Links 
 
The Live Links dialog box shows the block links created using Syscon and their state. 
 

ATTENTION 

The procedure to connect the links may take a few minutes depending on how many links were 
created in the project configuration files. To cancel the procedure that reads the status of the 
links, click Abort at the bottom of the Live Links dialog box. 
After closing the Live Links dialog box, wait a few seconds until Server Manager updates the 
monitoring information about the links. Otherwise, if the Live Links dialog box is quickly 
reopened, an error may occur while reading data from the OPC Servers and it will be necessary 
to restart Server Manager, close and open the Diagnostic window again. 

 
On the Customize tab, select the links from the configuration projects and Area Links that should 
be monitored. See the example below: 
 

 
Figure 7.9. Selecting Links 
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Click Next to continue. 
 

 
Figure 7.10. Live Links dialog box 

 
The SC column (State Change) indicates the number of changes in the parameter status. 
 

NOTE 

You can set the time interval to wait until stabilizing the reading of the status of each link in the 
Preferences dialog box. See section Defining User's Preferences. 

 
At the bottom of the Live Links dialog box, use the States filter to select the type of links that are 
listed: 
 

• Active: shows only links that are communicating. 

• Uncertain: shows links that the quality of the value is less than normal, but the value might 
be useful. 

• Dubious: shows links where the status of the publisher and subscriber parameter is out of 
service. 

• Broken: shows links that are communicating but the status in the subscriber is different 
from the publisher. 

 
Use the Behavior filter and mark the option Oscillating to show links that oscillated their status 
(active, broken and dubious) during the monitoring period. 
 
Use the filter No Communication at the Live Links Comm area to show links that are not 
communicating. 
 
Right-click the parameter tag and select Details to open Syscon and edit the link on the Strategy 
window. 
 
Right-click the parameter tag and select Reset State Change to reset the counter in the SC column 
related to the selected parameter. Or click Reset All State Change to reset all counters in the SC 
column. 
 
Click Refresh to read the information from the OPC Servers. 
 

IMPORTANT 

Do not change the project configuration files in Syscon while the Live List dialog box is reading 
the information from the OPC Servers to update the status of the links, otherwise it will be 
necessary to reconnect all links again, clicking the button Reconnect. 
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At the Search box, search a specific parameter tag from the Publisher node, the Subscriber node or 
the control module. Use the wild char '*' (asterisk) to replace characters at the beginning and the 
end of the parameter tag. For example, to locate the parameters from a PID block, type *PID* on the 
Search box and click Search. 
 

ADVANCED USERS - FILTERS FOR LINK TYPES 

The filters for the link types in the Live Links dialog box were defined based on the value related 
to the quality of the communication between blocks. Studio302 shows the status value 
represented by a number in decimal format. This value is interpreted in Syscon when opening 
the Block Characterization dialog box. 
Click the link icon and select Details to open Syscon and check the quality of the communication 
specific for the selected block parameter. 
The link can be classified as: 

 Broken Link: the link is classified as broken when: 
o The status of the Subscriber parameter is: 

 Bad::NoCommunicationWithLastUsableValue 

 Bad::NoCommunicationWithNoUsableValue 

o The status of the Subscriber parameter is Bad::OutOfService or different 
from the status of the Publisher parameter. 

o The status of the Subscriber and Publisher parameters is inferior to 27, that 
is, the value is between 0 and 27 (refer to the descriptive table below). 

 Dubious Link: the link is classified as dubious when: 
o The status of the Subscriber and Publisher parameters is 

Bad::OutOfService, which means the value is that is between 28 and 31 
(refer to the descriptive table below). 

 Uncertain Link: the link is classified as uncertain when: 
o The status of the Subscriber and Publisher parameters is Uncertain, which 

means the value is that is between 64 and 91 (refer to the descriptive table 
below). 

 Oscillating Link: the link is classified as oscillating when during monitoring (while the Live 
Links dialog box is open), the Quality Change of the link is not zero, 
indicating that the status of the link changed. 

 No Communication: the link is classified as not communicating when it is not possible to 
read the values of the Publisher and/or Subscriber parameters. 

 Active Link: to be classified as an active link: 
o The status of the Subscriber parameter must be the same status from the 

Publisher parameter. 
o Both values, from the status of the Subscriber parameter and the Publisher 

parameter, must be above 64 (refer to the descriptive table below). 

 
 
Descriptive Table for the Status value of the Block Parameters 
 
The figure in the example below shows the value of the Status for the parameter IN of the block 
APID, of the LD302, interpreted in the Block Characterization dialog box, in Syscon: 
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Figure 7.11. Example of a parameter status 

 
The values of the status are described below: 
 

Decimal 
Value Status of the parameter indicated in Syscon Hexadecimal 

Value 
0 Bad::NonSpecific:NotLimited (0x0) 
1 Bad::NonSpecific:LowLimited (0x1) 
2 Bad::NonSpecific:HighLimited (0x2) 
3 Bad::NonSpecific:Constant (0x3) 
4 Bad::ConfigurationError:NotLimited (0x4) 
5 Bad::ConfigurationError:LowLimited (0x5) 
6 Bad::ConfigurationError:HighLimited (0x6) 
7 Bad::ConfigurationError:Constant (0x7) 
8 Bad::NotConnected:NotLimited (0x8) 
9 Bad::NotConnected:LowLimited (0x9) 
10 Bad::NotConnected:HighLimited (0xa) 
11 Bad::NotConnected:Constant (0xb) 
12 Bad::DeviceFailure:NotLimited (0xc) 
13 Bad::DeviceFailure:LowLimited (0xd) 
14 Bad::DeviceFailure:HighLimited (0xe) 
15 Bad::DeviceFailure:Constant (0xf) 
16 Bad::SensorFailure:NotLimited (0x10) 
17 Bad::SensorFailure:LowLimited (0x11) 
18 Bad::SensorFailure:HighLimited (0x12) 
19 Bad::SensorFailure:Constant (0x13) 
20 Bad::NoComm_WithLastUsableValue:NotLimited (0x14) 
21 Bad::NoComm_WithLastUsableValue:LowLimited (0x15) 
22 Bad::NoComm_WithLastUsableValue:HighLimited (0x16) 
23 Bad::NoComm_WithLastUsableValue:Constant (0x17) 
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Decimal 
Value Status of the parameter indicated in Syscon Hexadecimal 

Value 
24 Bad::NoComm_WithNoUsableValue:NotLimited (0x18) 
25 Bad::NoComm_WithNoUsableValue:LowLimited (0x19) 
26 Bad::NoComm_WithNoUsableValue:HighLimited (0x1a) 
27 Bad::NoComm_WithNoUsableValue:Constant (0x1b) 
28 Bad::OutOfService:NotLimited (0x1c) 
29 Bad::OutOfService:LowLimited (0x1d) 
30 Bad::OutOfService:HighLimited (0x1e) 
31 Bad::OutOfService:Constant (0x1f) 
64 Uncertain::NonSpecific:NotLimited (0x40) 
65 Uncertain::NonSpecific:LowLimited (0x41) 
66 Uncertain::NonSpecific:HighLimited (0x42) 
67 Uncertain::NonSpecific:Constant (0x43) 
68 Uncertain::LastUsableValue:NotLimited (0x44) 
69 Uncertain::LastUsableValue:LowLimited (0x45) 
70 Uncertain::LastUsableValue:HighLimited (0x46) 
71 Uncertain::LastUsableValue:Constant (0x47) 
72 Uncertain::SubstituteValue:NotLimited (0x48) 
73 Uncertain::SubstituteValue:LowLimited (0x49) 
74 Uncertain::SubstituteValue:HighLimited (0x4a) 
75 Uncertain::SubstituteValue:Constant (0x4b) 
76 Uncertain::InitialValue:NotLimited (0x4c) 
77 Uncertain::InitialValue:LowLimited (0x4d) 
78 Uncertain::InitialValue:HighLimited (0x4e) 
79 Uncertain::InitialValue:Constant (0x4f) 
84 Uncertain::EngUnitRangeViolation:NotLimited (0x54) 
85 Uncertain::EngUnitRangeViolation:LowLimited (0x55) 
87 Uncertain::EngUnitRangeViolation:Constant (0x57) 
88 Uncertain::Subnormal:NotLimited (0x58) 
89 Uncertain::Subnormal:LowLimited (0x59) 
90 Uncertain::Subnormal:HighLimited (0x5a) 
91 Uncertain::Subnormal:Constant (0x5b) 

128 Good_NonCascade::NonSpecific:NotLimited (0x80) 
129 Good_NonCascade::NonSpecific:LowLimited (0x81) 
130 Good_NonCascade::NonSpecific:HighLimited (0x82) 
131 Good_NonCascade::NonSpecific:Constant (0x83) 
135 Good_NonCascade::ActiveBlockAlarm:Constant (0x87) 
192 Good_Cascade::NonSpecific:NotLimited (0xc0) 
193 Good_Cascade::NonSpecific:LowLimited (0xc1) 
194 Good_Cascade::NonSpecific:HighLimited (0xc2) 
195 Good_Cascade::NonSpecific:Constant (0xc3) 
204 Good_Cascade::NotInvited:NotLimited (0xcc) 
205 Good_Cascade::NotInvited:LowLimited (0xcd) 
206 Good_Cascade::NotInvited:HighLimited (0xce) 
207 Good_Cascade::NotInvited:Constant (0xcf) 
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Decimal 
Value Status of the parameter indicated in Syscon Hexadecimal 

Value 
208 Good_Cascade::NotSelected:NotLimited (0xd0) 
209 Good_Cascade::NotSelected:LowLimited (0xd1) 
210 Good_Cascade::NotSelected:HighLimited (0xd2) 
211 Good_Cascade::NotSelected:Constant (0xd3) 
212 Good_Cascade::DoNotSelect:NotLimited (0xd4) 
213 Good_Cascade::DoNotSelect:LowLimited (0xd5) 
214 Good_Cascade::DoNotSelect:HighLimited (0xd6) 
215 Good_Cascade::DoNotSelect:Constant (0xd7) 
216 Good_Cascade::LocalOverride:NotLimited (0xd8) 
217 Good_Cascade::LocalOverride:LowLimited (0xd9) 
218 Good_Cascade::LocalOverride:HighLimited (0xda) 
219 Good_Cascade::LocalOverride:Constant (0xdb) 
220 Good_Cascade::FailSafeActive:NotLimited (0xdc) 
221 Good_Cascade::FailSafeActive:LowLimited (0xdd) 
222 Good_Cascade::FailSafeActive:HighLimited (0xde) 
223 Good_Cascade::FailSafeActive:Constant (0xdf) 
224 Good_Cascade::InitiateFailSafe:NotLimited (0xe0) 
225 Good_Cascade::InitiateFailSafe:LowLimited (0xe1) 
226 Good_Cascade::InitiateFailSafe:HighLimited (0xe2) 
227 Good_Cascade::InitiateFailSafe:Constant (0xe3) 

 
 

Wise Inspector 
 
The Wise Inspector window lists all Inventory Reports saved on the database. 
 

 
Figure 7.12. Example of a parameter status 

 
The Inventory Report lists all files located in the SYSTEM302 installation folder and indicates the 
hardware characteristics for the local machine (where SYSTEM302 was installed). This report has 
two sections. The Hardware section shows the configuration of the local machine, including the 
machine name, operating system version, hard disk space, network adapters, etc. The Software 
section lists all files related to each installed SYSTEM302 application, including the file name, 
installation path, date, size and file version. 
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To generate an Inventory Report, go to the Tools menu and click Reports > Inventory, or click 

the button  to open the Choose Report dialog box and click Inventory. 
 
You can also configure Studio302 to generate the Inventory Report each time Studio302 is 
launched. On the File menu, click Preferences. On the Preferences dialog box, click the Reports 
tab and mark the option Generate an Inventory Report when Studio302 is launched. 
 
You can select only two reports to compare system configurations. 
 
On the Tools menu, click Wise Inspector to open the Wise Inspector window. Mark the two 
reports you want to compare and click Compare. See the example below: 
 

 
Figure 7.13. Comparing Inventory Reports 

 
This procedure may take some minutes. Click Background on the progress dialog box to execute 
this procedure in background while you continue using Studio302. Click Abort on the Wise 
Inspector window at any time to cancel the comparison. 
 
When the procedure is concluded, the report containing the differences between the selected 
Inventory Reports will be displayed. Differences are generated according to three cases: 
 

1. If a file exists on the first Inventory Report and does not exist on the second, the final 
report will indicate the file as not found. 

2. A new file does not exist on the first Inventory Report. 
3. A modified file, that is, the file exists on the first Inventory Report and it was modified. 

 

 
Figure 7.14. Report Information 
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On the Reports window, click  to print the report or click the button  to save the report in 
PDF format. 
 
 
Importing an Inventory Report 
 
You can import the information from an Inventory Report previously saved on the workstation, and 
then compare this report to other Inventory Reports available. 
 
On the Tools menu, click Wise Inspector to open the Wise Inspector window. Click the button 
Import. 
 
 
On the Open dialog box, locate the folder where the file was saved. Double-click the file icon to 
import the report to the Wise Inspector window. 
 
 
Exporting an Inventory Report 
 
You can export the information from an Inventory Report and save it to a file. 
 
On the Tools menu, click Wise Inspector to open the Wise Inspector window. Select the 
Inventory Report available and click Export. You can select one or more reports at the same time, 
each report will be export as one file. 
 
On the Browse for Folder dialog box, select the folder where the files will be saved. Click Ok to 
export the selected file(s). The file extension will be "*.wif". 
 
 

Wise Inspector Backup 
 
 
The Wise Inspector Backup is a new feature in Studio302 version 1.11 on. This feature creates a 
backup from a set of SYSTEM302 files by comparing two Inventory Reports. 
 
 
How to use the Wise Inspector Backup? 
 
From SYSTEM302 version 7.3.5 on, when launching Studio302 for the first time, an Inventory 
Report related to the installation is automatically generated, and the information is store on the 
Inventory database. 
 
After the SYSTEM302 installation/configuration, it might have been necessary to alter an element 
from the original installation, which means a component may have been added or altered due to 
improvements or specific customizations made by the Smar Tech Support team. 
 
Once the alteration is validated, another Inventory Report related to the installation should be 
generated. This report will also be stored on the Inventory database. 
 
 
How to generate a backup? 
 
On the Tools menu, click Wise Inspector to open the Wise Inspector window. Click the button 
Backup. The tool will automatically select the first and the last Inventory Report from the current 
SYSTEM302 version. 
 
You will save the information about the differences and the altered components in a compacted file. 
This file can be stored on the current workstation, and could be used for comparison if it is 
necessary to reinstall SYSTEM302. These records of the SYSTEM302 validated installation and the 
components that were altered follow the same directory structure of the Smar directory. 
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On the Save As dialog box, select the folder where the file will be saved and type the name for the 
compacted file. Click Save to continue. This procedure may take some minutes. Click Background 
on the progress dialog box to execute this procedure in background while you continue using 
Studio302. 
 
At the end of the backup procedure, the compacted file is generated in zip format. This file contains: 
 

• the Source directory: files are copied according to the SYSTEM302 directory structure, 
making it easy to locate files that were altered. 

• the info.txt file: this file contains the information related to the files that were copied. 
 
 



Section 8 
 

8.1 

TASKS 
 

Area Link Tool 
 

Click the button  to select the Area Link Tool application. 
 

 
Figure 8.1. Area Link Tool Window 

 
 

AssetView 
 

Click the button  to select the AssetView Application. The following dialog box will open: 
 

 
Figure 8.2. Initializing AssetView 

 
Click the option AssetView Web Browser to launch the Internet Explorer browser and navigate 
through the AssetView pages related to the configurations imported to the current database. 
 
Click the option AssetView Server to run the application and manage the device information on the 
AssetView database. Refer to the AssetView User’s Manual for further details. 
 
Click the option AssetView HART and Profibus Features to run the FDT HART Configurator tool 
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and manage the topology and DTMs from HART and Profibus devices. 
 
 

DFI Diver 
Click the button  to launch the DFI Diver application and select a DF51 card to debug. 
 

 
Figure 8.3. Initializing DFI Diver 

 
Select the DF51 card and click Apply to apply the debug the card. 
 

FBTools 
 

Click the button  to launch the FBTools Wizard. This is an application which allows the firmware 
upgrade of any Smar field device - FOUNDATION™ fieldbus and PROFIBUS PA, PCI302 cards, 
DFI302 controllers and communication gateways such as the FB700, MB700, and HI302. This tool 
also allows configuring TCP/IP properties of those modules network interfaces. Refer to the 
FBTools Help for further details. 
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Figure 8.4. Initializing FBTools 

 

FBView 
 

Click the button  to launch the FBView application and analyze the network communication. 
Refer to the FBView User’s Manual for further information. 
 

 
Figure 8.5. Initializing FBView 

 

FDT HART Configurator 
 

Click the button  to launch the FDT HART Configurator. 
 
This FDT tool manages specific functions for each instrument, providing online asset management. 
 
Refer to the FDT HART Configurator manual for further details. 
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LicenseView 
 

Click the button  to run the LicenseView application and authorize the installed products. 
 

 
Figure 8.6. Initializing LicenseView 

 
Refer to the SYSTEM302 HANDBOOK for further information about licenses. 
 
 

LogicView 
 

Click the button  to open the dialog box to select the Action Mode for the LogicView 
application: 
 

 
Figure 8.7. Initializing LogicView 

 
• New FFB Logic Template: opens LogicView for FFB to configure and edit the FFB 

templates. 

• DF65 Logic: opens LogicView to configure the logic for the coprocessor DF65. 

 
Refer to the LogicView User’s Manual for further information. 
 
 

Profibus View 
 

Click the button  to open the ProfibusView dialog box and configure a Profibus device. Refer to 
section Detecting a Profibus Device on the Studio302 User’s Manual for further details. 
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Figure 8.8. Opening the Profibus View dialog box 

 
 

ProcessView 
 

Click the button  to open the ProjectWorX application and organize the ProcessView 
configuration and supervision files. 
 
Refer to the ProcessView User’s Manuals for further information. 
 
 

System302 ServerManager 
 

Click the button  to open the System302 ServerManager window. When an OPC server is 
executing, the icon of the System302 ServerManager will change to green ( ) at the Windows 
taskbar. If the server is stopped, the icon of the System302 ServerManager will change to red ( ) 
at the Windows taskbar. 
 

 
Figure 8.9. Initializing the System302 Server Manager 

 
Refer to the Appendix A System 302 ServerManager for further details about this application. 
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ATTENTION 

When closing the System302 ServerManager application, wait a few seconds before initializing 
it again. This way, the list of processes executed by the operational system will be updated and 
the System302 ServerManager application will be removed from this list. 
If the user tries to execute the System302 ServerManager right after closing the application, the 
System302 ServerManager icon will not appear on the Windows taskbar because the process 
will be still active on the list of processes. 

 
 

SimulationView 
 

Click the button  to open the SimulationView that is a control strategy simulator developed 
specifically to simulate control strategies with FoundationTM Fieldbus function blocks and ladder 
logic IEC 61131-3 standard. 
 
Refer to the SimulationView Manual for further information. 
 

 
Figure 8.10. Initializing the SimulationView 

 
 

Syscon 
 

Click the button  to launch the Syscon application and edit a project configuration. Refer to the 
Syscon User’s Manual for further details. 
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Figure 8.11. Initializing Syscon 

 
 

TagList 
 

Click the button  to launch the TagList application and configure the database for the DF65 
OPC Server. 
 

 
Figure 8.12. Initializing TagList 

 
 

TagView 
 

Click the button  to launch the TagView application and monitors the Function Blocks and their 
parameters. 
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Figure 8.13. Initializing TagView 

 

System302 Documentation 
 

Click the button  to open the SYSTEM302 Documentation Browser. 
 

 
Figure 8.14. SYSTEM302 Main Documentation Browser 

 
ATTENTION 

To open the files of the user’s manuals, it is necessary to install Adobe Acrobat Reader version 
8.0 or higher. The installation file is available on the SYSTEM302 Installation media, on the 
Tools folder. 

 



Section 9 
 

9.1 

TUTORIAL: DEVICE MAINTENANCE 
 

Replacing the Device in the Plant 
 
This section describes the steps of the device maintenance in the plant. 
 
When the fieldbus device is replaced in the plant, first it must be decommissioned using the 
configuration tool, and then the device can be removed from the plant and a new device is 
connected. To conclude this procedure, the new device must be commissioned by the configuration 
tool. 
 
The Studio302 wizard guides the user during the maintenance procedure, interacting with the 
configuration tool and assisting the user. 
 
Step 1: Decommissioning the device 
 
In the Studio302 window, open the device list expanding the icon Network Devices and clicking 
Field Devices in the topology tree. 
 
The list of the devices will open. Right-click the icon of the device that will be replaced and click 
Decommission.  
 
Wait a few seconds while Syscon is decommissioning the device. When this procedure is complete, 
the device status will be updated in the Devices dialog box. 
 
After decommissioning the device, replace the physical instrument with the new equipment in the 
plant. 
 
 
Step 2: Detecting the new device 
 

IMPORTANT 

Remember that the device detection service must be started for the new device installed in the 
plant to be detected. 
If the Detect Device icon is not activated in the Windows taskbar, go to the Settings menu in the 
Studio302 window, click Communication to open the Communication Settings dialog box, 
select the Services tab and click Start to activate the device detection service. 
It is also possible to initialize the device detection service clicking the Online/Offline 
Communication button on the main toolbar. 

 
 
When a new device is connected to the plant communication channel, the Studio302 icon blinks in 
the Windows taskbar. 
 
Open the Studio302 window and the New Device Detected message box will open. 
 
Click Yes to commission the new device. The commissioning process will enable the device 
communication with the plant control. 
 
 
Step 3: Commissioning the Device 
 
Syscon will be automatically executed, and the Commission dialog box will open. 
 

Click the button  to open the list of device IDs available. 
 
Select the icon corresponding to the new device and click Ok to close this dialog box and return to 
the Commission dialog box. Click Ok again and wait until the device is commissioned. 
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The message box will open informing the user the commissioning procedure was completed. 
 
 
Step 4: Download 
 
After commissioning the new device, a message box will open informing the user that it will be 
necessary to send the information about the device configuration to the physical instrument in the 
plant. Click Yes to download the configuration and conclude the device maintenance. 
 
If any attribute of the new device installed in the plant differs from the configuration of the virtual 
device in the project file, the message below will open after the device is commissioned, alerting the 
user that it will be necessary to execute the Exchange Device procedure to check the 
inconsistencies, incompatibilities and the instability of the device. 
 

  
Figure 9.1. Editing Groups Permissions 

 
Click Yes to analyze the differences of the devices and select the blocks and parameters compatible 
to the new device. 
 
Refer to the Syscon User's Manual for further details about the Exchange Device procedure. 
 
After confirming the alterations on the device configuration, download the configuration to conclude 
the device maintenance. 
 
 
 



Appendix A 
 

A.1 

SYSTEM302 SERVERMANAGER 
 
The System302 ServerManager configures the parameters for the plant network communication. 
Parameters can be configured before starting the online communication, and some parameters can 
be modified while the system is already operating. 
 
The System302 ServerManager is executed from the Studio302 toolbar. Note that an option can 
be configured in order to also execute System302 ServerManager automatically every time an 
OPC server is accessed. 
 

 
Figure A.1. System302 ServerManager on the Studio302 Toolbar 

 
IMPORTANT 

Parameters available in System302 ServerManager are read from the files SmarOleServer.ini, 
IDShell HSE.ini and SnmpOpcServer.ini. 
Any alterations made directly on these files, for other parameters non-accessible through 
System302 ServerManager, without previous knowledge or technical orientation, may cause 
system malfunctioning. 

 
 
The sections below describe the System302 ServerManager interface and its main characteristics. 
 
 

User Interface 
 
Click the button System302 ServerManager on the Studio302 toolbar and the following dialog box 
will open: 
 

 
Figure A.2. Starting the System302 ServerManager 

 
Select one of the options according to the configuration settings to be edited: 
 

• Network: configure the network interface cards used by the System302 ServerManager, 
and also redundancy, advanced parameters for HSE network, specific parameters for 
SNTP and parameters for the case of a system composed by RTUs. 

• Logs: configure the options to enable or disable the event logs. 

• Startup: configure the System302 ServerManager to activate the OPC servers 
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automatically when the operational system starts, and also read the tag list to create a 
cache for the DA server (DFI or HSE). 

• OPC: configure specific parameters for the Alarms and Events, SNMP and HDA servers. 
Access to wrapper of OPC UA standard.  

 
While being executed, System302 ServerManager alerts the user about events related to system 
components through its icon on Windows taskbar. There are four possible events indicated by the 
System302 ServerManager icon: 
 

• Error in the COM/DCOM configuration; 
• Event generated by an application, creating a *.sml log file; 
• Database from A&E OPC Server must be updated; 
• A new dump file (from a fatal exception of one of the components related to the OPC 

Servers) was generated by the system (see section Displaying Log Files for details). 
  
See the example in the figure below: 
 

 
Figure A.3. Events in System302 ServerManager 

 

When an OPC server is active, System302 ServerManager icon changes to green ( ) on the 
Windows taskbar. On the other hand, if the server is stopped, System302 ServerManager icon 

changes to red ( ) on the Windows taskbar. 
 
The figure below shows the System302 ServerManager interface: 
 

 
Figure A.4. System302 ServerManager Window 
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The panel on the left shows the configuration options and the reports generated during the 
communication server operation. 
 
The panel on the right shows the configuration parameters according to the option selected from the 
menu on the left. Place the mouse cursor over a parameter to active the tool tip and display a brief 
description about the parameter. 
 
The panel on the bottom of the System302 ServerManager window shows information related to 
databases from DFI and HSE OPC Servers, indicating which servers are valid and non-valid, and 
the total number of servers. This panel also indicates which servers are being executed. 
 

 
Figure A.5. Information related to the OPC Servers 

 
After editing the configuration parameters, click Apply All to confirm the alterations and close the 
System302 ServerManager. Depending on which parameters were edit, it may be necessary to 
restart System302 ServerManager to apply the changes. 
 
To shut down System302 ServerManager, go to the Application menu and click Exit, or right-click 
the System302 ServerManager icon on the taskbar and select Exit. The close button  on the 
upper right side of the System302 ServerManager window simply minimizes the application. 
 

 
Figure A.6. Shutting down System302 ServerManager 

 
System302 ServerManager shuts down only if there is no OPC Server being executed. Close all 
OPC clients and if there are OPC servers being executed, then System302 ServerManager itself is 
being considered an OPC client. To disconnect System302 ServerManager as an OPC client, go 
to the Application menu and click Disconnect OPC Servers. 
 
You can also use the buttons on the OPC toolbar to disconnect an OPC server. When the button 
related to a server is selected on the OPC toolbar, it indicates the server is connected to 
System302 ServerManager. Refer to section Configuring Startup for further details. 
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Figure A.7. OPC Toolbar 

 
IMPORTANT 

When closing System302 ServerManager, wait a few seconds before initializing it again. This 
way, the list of processes executed by the operational system will be updated and the 
System302 ServerManager application will be removed from this list. 
If the user tries to execute System302 ServerManager right after closing the application, the 
System302 ServerManager icon will not appear on the Windows taskbar because the process 
will be still active on the list of processes. 

 
Another System302 ServerManager functionality is to verify the current role of the Host. The 
IDShell HSE can execute two roles in a fieldbus network: it may be a Configurator or being 
executed on Supervision Only mode. To check the current role of a HSE OPC Server while it is 
being executed, go to the Application menu, and click Check Server role, or right-click the 
System302 ServerManager icon on the taskbar, and click Check Server role. 
 

 
Figure A.8. Checking the IDShell HSE role 

 
 

Configuring the Communication Network 
 
On the System302 ServerManager window, select the option Settings > Network to configure the 
interface cards used by the System302 ServerManager. 
 

’ 

Figure A.9. Configuring the Communication Network 
 

• At the General tab, configure the number of NICs (Network Interface Cards) and the IP 
addresses. 

• At the HSE Redundancy tab, configure the network and HSE device redundancy. 
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• At the Advanced tab, configure the synchronization and the schedule for the supervisory. 

• The HSE Maintenance tab is only available for users with Administrator rights and allows 
the administrator to delete the files related to the HSE persistency. 

• At the SNTP tab, configure the Application Clock Time. Used for configuring the 
parameters related to time synchronism. 

• The RTU tab must be configured only if the application uses remote access. In this tab, 
mark the option to enable the RTU mode and configure the necessary parameters for 
proper operation. 

 
 
Configuring the number of Network Interfaces (NIC) 
 
Click the option Network to open System302 ServerManager at the Network > General tab. 
 

 
Figure A.10. System302 ServerManager: General Tab 

 
• Type the number of NICs used by the System302 ServerManager in the HSE network. 

The number of NICs depends on the system redundancy, that is: 

o If the system is not redundant, only one NIC will be used to manage the 
communication, therefore type 1 in the Number of NICs textbox. 

o If the system is redundant, two NICs will be necessary to manage the 
communication, therefore type 2 in the Number of NICs textbox. 

 
• Select the IP address of the NICs used by the System302 ServerManager. System302 

ServerManager automatically lists the addresses of the adapters available in the local 
machine. 

 
 
Configuring the HSE Redundancy 
 
If the system is redundant, select the HSE Redundancy tab and configure the following parameters: 
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Figure A.11. System302 ServerManager: HSE Redundancy Tab 

 
• Select ON for the parameters Device Redundancy and LAN Redundancy. 

 
• At the Device Index text box, type a value between 1 and 9 for each machine, and every 

machine must have a unique number. In the HSE network, the Device Index represents the 
network address for each equipment, therefore if the values are not unique for each 
machine, the network redundancy will not work correctly. 

 
 
Configuring Synchronization and Supervision 
 
At the Advanced tab: 
 

 
Figure A.12. System302 ServerManager: Advanced Tab 

 
Supervision: 
 

• The Update Time parameter indicates the desired time interval to update the supervisory 
system. This interval should not be smaller than the macrocycle. 

• The MVC Enable parameter enables the supervision optimization using the MVC 
resources available. 

• The No DataChange Timeout parameter indicates the time interval to update the 
parameters that have not changed their values. 

• The Analog Views parameter allows the user to create views for the 1131 supervision of 
analog variables. 
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Server role: 
 

• Mark the option Configurator only for the machine where the plant configuration files are 
created. For the other machines where SYSTEM302 is also installed, mark the option 
Supervision Only to indicate that they are acting in supervision mode only. 

 
 
Configuring Message Concatenation 
 
Starting with SYSTEM302 version 7.0.6, firmwares of all HSE controllers in DFI302 implements the 
Message Concatenation method. This feature allows you to configure a control strategy with a 
higher number of external control links between controllers, because it reduces processing load in 
the controllers. 
 
At the Advanced tab: 
 

 
Figure A.13. Configuring message concatenation 

 
Message Concatenation: 
 

• The Transmit Delay Time parameter indicates the time interval that controls the 
concatenation of link publishing messages by the HSE controllers. This interval must be 
equal to half of the macrocycle, in milliseconds. 

 
 

IMPORTANT 

After configuring the Transmit Delay Time, restart the HSE OLEServer and download the 
plant configuration or the HSE fieldbus channel using Syscon to enable the message 
concatenation method in all HSE controllers. 

 
 
Deleting HSE persistency files 
 
The HSE Maintenance tab is only available if the user is the System Administrator or a member of 
the Administrators Group. Only the user with Administrator rights can delete the files related to the 
IDShell HSE persistency. 
 
Before deleting the persistency files, make sure the HSE OLE Server is not active and stop the 
network communication with all OPC clients, such as Studio302 and Syscon. On the System302 
ServerManager window, go the Application menu and click Disconnect OPC Servers. A 
message box will appear to confirm the operation. Click Yes to conclude. 
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IMPORTANT 

The procedure to delete the files related to the HSE persistency can hazard the system 
operation. 
Since this procedure is not often executed and it is considered an immediate solution, the HSE 
Maintenance tab will only be available during a 5-minute interval when the System302 
ServerManager is executed for the first time. 

 
At the HSE Maintenance tab, click the button Delete to remove the files related to the HSE 
persistency. 
 

 
Figure A.14. System302 ServerManager: HSE Maintenance Tab 

 
A message box will appear informing the user about the hazards when executing this procedure. 
Click Yes to conclude. 
 

 
Figure A.15. Confirming the operation 

 
 
Configuring the SNTP 
 
Click the SNTP tab to configure parameters to synchronize computer clocks on the network. 
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Figure A.16. System302 ServerManager: SNTP Tab 

 
Sync And Scheduling: 
 

• Set the IP addresses of the SNTP Servers. If there is only one SNTP Server, type the 
Primary SNTP Server address and leave the Secondary address blank. If the machine 
where the SNTP Server is running has more than one NIC, you may choose an alternative 
IP as the Secondary address as long as both IPs are reachable on the network. Contact 
the information technology administrator and request the SNTP time server addresses 
available for the system. 

• The parameters Request Timeout and Request Interval should not be altered. Request 
Timeout is the time (in milliseconds) that the SNTP Time Client waits for the Time Server 
to answer a time request in the HSE Network (the default value is 10,000 ms). Request 
Interval is the time (in milliseconds) that the SNTP Time Client waits to send requests to 
the Time Server in the HSE Network (the default value is 25,000 ms). 

• Standard Time Difference: This variable contains the value to add to the current time to 
obtain Standard time-stamp. The default value is 0. 

• Daylight Time Difference: This variable contains the value to add to the current time to 
obtain Daylight time-stamp. The default value is 0. 

• Start Daylight: This variable indicates the beginning of Daylight Saving Time. 

• End Daylight: This variable indicates the last day of Daylight Saving Time. 
 
Note that the fields on the SNTP tab will be disabled if the system is configured as Supervision 
Only. To check the supervision mode, click the Advanced tab and the option Supervision Only 
must be selected on the Server Role area. 
 

 
Figure A.17. Configuring SNTP 

 
 
Configuring the RTUs option 
 
Click the RTUs tab to configure the parameters related to RTUs (Remote Terminal Unit) system. 
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Figure A.18. System302 ServerManager: RTUs tab 

 
Enable RTU Mode:  
Use this checkbox to enable or disable RTU mode. For RTU mode, it is necessary to have a NAT-
compatible router between the workstation and the RTU. It is assumed that the RTU is connected 
behind this router using its first Ethernet interface (eth1). The second ethernet interface (eth2) will 
only be used for engineering / maintenance through an Ethernet cable between a workstation and 
the RTU. After connecting this Ethernet cable, all HSE communications through eth1 will be 
interrupted. When the crossover cable is disconnected, HSE communications via eth1 are enabled 
again. 
 
HSE Persistency:  

• Read Only (Locked) –It does not allow any additional recording to the HSE device 
database. 

• Writable (unlocked) - - Allows recordings in the HSE device database. 
 
Workstation Role:  

• Engineering/Maintenance (eth2) - In this function, the second ethernet interface (eth2) is 
used for engineering / maintenance through an ethernet cable between a workstation and 
the RTU. 

• Operation (eth1) - In this function, the first ethernet interface (eth1) is used for the 
operation. A NAT-compatible router is required between the workstation and the RTU. 
 

Network Settings:  
• RTU Ethernet 1 - IP address used on the RTU for its first Ethernet port.  
• RTU Ethernet 2 - IP address used on the RTU for its second Ethernet port. 
• Router IP - IP address used on a NAT-compatible router for its Ethernet WAN port. 

 
 

IMPORTANT 
There is a parameter directly related to OPC operations by LogicView that is changed from the 
options defined in this RTUs tab. 
OPC Timeout - is changed by default from the choices made on this tab, namely: 
1500 milliseconds if RTU mode is disabled or in Engineering / Maintenance mode, or from the 
value determined in LogicView (see the LogicView Manual to learn more) or 15000 milliseconds 
for operation mode. 

 
 

Configuring Startup 
 
Click the option Startup to configure System302 ServerManager to activate OPC servers based on 
a list of tags. Servers can be automatically executed when the operation system starts. 
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Figure A.19. System302 ServerManager: Startup Tab 

 
In the Load Server area, select the standard OPC server to be activated (DFI and/or HSE). When 
selecting the DFI and HSE servers, click the Browse button to select the .lst file that contains the 
list of tags from the plant process control. 
 
To select another OPC server, mark the option OPC Server, click the Browse button to select the 
.lst file and type the ProgID (OPC server identification) of the server that will be activated by 
System302 ServerManager. 
 
The Concentrator option will be detailed in the next item. Check this option to launch the 
Concentrator as soon as the System302 ServerManager is run. 
 
The following options are available on the Startup tab: 
 

• Check the item Ask for confirmation on exit to force the user to confirm the operation 
when shutting down System302 ServerManager. 

• Check the item Start System302 ServerManager when Windows starts up to start 
System302 ServerManager with the operational system. 

• Check the item Start System302 ServerManager when OPC Server starts up to start 
System302 ServerManager every time an OPC server is initialized. 

 
The OPC toolbar located below the main menu indicates which OPC servers are currently 
connected to System302 ServerManager when the button related to the server is selected. To 
disconnect an OPC server, click the corresponding button.  
 

 
Figure A.20. OPC Toolbar 

 
Generating the lst file 
 
The lst file is generated according to the supervisory system configuration related to the plant 
process control. Follow the procedure below to enable the lst file and create the list of tags for 
supervision: 
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1. Close all SYSTEM302 applications, including the supervisory tools and the System302 

ServerManager. 

2. Locate the file SmarOleServer.ini on the OleServers directory. The default path of the 
SYSTEM302 installation folder is “C:\Program Files\Smar\OleServers”. 

3. Edit the SmarOleServer.ini file using the Windows Notepad or other text editor. See the 
example below: 

 
Figure A.21. SmarOleServer.ini file 

 
4. Locate the section SMFILEGEN and type the value 1 to generate the lst file. Save the 

alterations and close the text editor. 

5. Run System302 ServerManager. 

6. Using the supervisory tool, open the screens which contain the points that will be read 
when the operational system is started. This step will update the list of tags in the lst file. 

7. At this point, there are two options to conclude the process: 

a. Close all SYSTEM302 applications, including supervisory tools and System302 
ServerManager. In this case, System302 ServerManager will be automatically 
configured with the lst file generated and for being executed when the operational 
system restarts, initializing the OPC server. 

OR 

b. Edit the file SmarOleServer.ini and change the SMFILEGEN key value to 0 
(zero). Close the editor saving the file, which will be created with all added items. 

 
Now the lst file is created. The steps below are optional and specifically to test the lst file and create 
the cache list for the OPC server. 
 

8. Run System302 ServerManager again. 

9. If you execute step 7.a, System302 ServerManager is already configured with a file with 
the name format SMFileGen_DDMMMYY_HHMM.lst. otherwise, if you executed step 7.b, 
select the OPC server that will be executed and click the button Browse to select the lst 
file. 

10. Restart System302 ServerManager so the changes will take effect. 

 
When the operating system is restarted, the selected OPC servers will be automatically executed. In 
order to use the lst file with other application, such as TagView, unmark the options automatically 
configured during the process to create the lst file. 
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Configuring the OPC 
 
On the System302 ServerManager window, select the option Settings > OPC to configure the 
Smar’s OPC servers. 
 

• At the SNMP tab, configure the list of available agents and their supervision settings. 

• At the A&E tab, create the database with the initial conditions for the Smar A&E OPC 
Server to identify which events will be monitored. 

• At the UA tab, the Concentrator (wrapper) can be enabled that allows access to the OPC 
Server by the OPC UA standard. 

 
 
Configuring the SNMP OPC Server 
 
The SNMP OPC Server provides important diagnostics information from the DFI302 to compliant 
OPC clients via the SNMP (Simple Network Management Protocol). 
 
The SNMP protocol defines agents and managers. Using SYSTEM302, DFI302 acts as an agent 
and the SNMP OPC Server act as a manager. The SNMP allows read and write transactions 
between agents and managers. 
 
The SNMP OPC Server configuration consists of listing the agents available and their respective 
network addresses. 
 

 
Figure A.22. System302 ServerManager: SNMP Tab 

 
Supervision: 
 

• At the Scan Rate text box, define the rate interval for the server to poll the agents for 
information. The value is defined in seconds and it should not be changed often. 

• At the Timeout text box, define the timeout for SNMP requests. The value is defined in 
milliseconds. Requests with responses exceeding the timeout period will result in bad 
quality for the associated OPC items. This setting should be changed only in cases of 
extremely loaded networks. 

 
Agents: 
 

• The Agents field lists all configured agents. There should be a user-defined tag assigned 
to each agent, limited to 32 characters. This tag will be used to build the OPC tags 
available in the server address space. Besides the tag, the user must specify the network 
addresses of the agents. Agents with two network interfaces should have both addresses 
specified. If only one address is specified, the System302 ServerManager will only send 
SNMP requests to that interface and the network redundancy will not be available. 
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The SNMP server supports 64 agents. To add an agent, right-click the Agents list and select the 
option Insert from the popup menu: 
 

 
Figure A.23. Adding a new Agent 

 
On the SNMP Agent dialog box: 
 

 
Figure A.24. Setting a new Agent 

 
1. Select one of the DF modules from the Device Type list. 

2. Type the tag name, which should not exceed 32 characters. 

3. Type the IP address for the NIC 1. This address must be always specified. 

4. If there is another network interface available, type the IP address for the NIC 2. 

 
To remove an agent, right-click the agent icon that should be removed and select Delete. 
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Figure A.25. Deleting an Agent 

 
On the SNMP Agent dialog box, click Delete to confirm the operation. 
 

 
Figure A.26. Confirming the operation 

 
To remove all agents from the list, right-click the Agents list and select Clear All. A message box 
will appear to confirm the operation. Click Yes to remove all agents from the list. 
 

 
Figure A.27. Deleting all agents 

 
 
Configuring the A&E Server 
 
The Alarms & Events OPC Server uses the information from the AlarmInfo.ini file to generate the 
initial conditions and identify which events will be monitored. 
 
When executed for the first time, before creating the database, the A&E OPC Server may take a 
few minutes to startup depending on the number of devices configured to generate alarms and 
events that should be monitored by the server. Use System302 ServerManager to create the 
database for the A&E OPC Server with the information generated by the configuration tools and, 
therefore, the server startup will be faster. 
 
Click the button Generate Database to create the database with the initial conditions for the A&E 
OPC Server. A message box will open alerting the user that this operation may take a few minutes 
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to be completed. Click Yes to proceed. 
 

 
Figure A.28. Generating initial database for A&E OPC Server 

 
System302 ServerManager alerts the user when the alarm database is not updated. When a new 
AlarmInfo.ini file is created by Syscon, System302 ServerManager detects this event and the 
icon on Windows taskbar indicates the database is outdated. See the following example: 
 

 
Figure A.29. Alert from A&E OPC Server 

 
This tab also displays information related to the number of devices and blocks configured with 
alarms. 
 
 
Using the Concentrator (Wrapper) for the OPC UA Server 

 
The wrapper for OPC UA provides data from the OPC DA 2.0 HSE OPC Server or DFI OPCServer, 
to the OPC UA standard. 
 

 
Figure A.30. System302 ServerManager: UA Tab 

 
 
The first time the application is executed, it automatically guides the user to record the certificates 
required for the application to work properly. 
 
Click Execute and use an OPC UA client to connect to the OPC UA wrapper. 
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Configuring Logs 
 
Click the option Logs on the left panel in the System302 ServerManager window to configure the 
options to enable or disable event logs. 
 

 
Figure A.31. System302 ServerManager: Logs Tab 

 
It is not necessary to restart each OPC server to generate event logs. However, for the options 
related to the IDShell HSE, it is necessary to restart the OPC server to start registering logs after 
configuring the events. 
 
It is recommended to click the button Empty LOG files before selecting reports to assure that 
previous information is deleted from the log files before registering new logs. 
 
 

Displaying Log Files 
 
System302 ServerManager manages log files from SYSTEM302 applications that generate alerts 
to the users. 
 
For each new message, the System302 ServerManager icon on the taskbar alerts the user about 
the event and the file related to that log is highlighted on the panel at the left side of the System302 
ServerManager window. 
 

 
Figure A.32. List of Log Files 

 
When an event log file is generated, it is available on the list of reports from the Log menu, on the 
left panel. Click the name of the log file to open the report and display the last messages generated. 
 
Click the button Open the file available on the message panel to open the log file and display all 
messages stored in that file. 
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Figure A.33. Opening a Log File 

 
You can associate a text editor application, such as Notepad, to open log files with the extension 
*.sml (ServerManager Log) automatically. 
 
Every time a new message is generated in a log file, the System302 ServerManager icon on the 
taskbar will alert the user about that event. See the following example: 
 
 

 
Figure A.34. Alert from the System302 ServerManager icon 
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CONFIGURING THE DCOM PROPERTIES 
FOR STUDIO302 GROUPS 
 
This tutorial describes the procedure to configure some security properties in order to enable proper 
communication among components. 
 
The DCOM properties must be configured only for the Studio302 Groups where the default 
permissions were edited. To verify which groups should be configured, open the List of Groups 
and Permissions dialog box. In the Studio302 window, go to the Settings menu, select Security 
and click Group Management. 
 
The figure below shows an example where the permissions for the groups "Users" and 
"Administrators" were altered and therefore only these two groups must be configured in the DCOM 
properties. 
 

 
Figure B.1. List of groups and permissions 

 
The DCOM properties must be configured every time the List of Permissions is altered. 
 

ATTENTION 
By default, if the user is logged on the local machine, the groups "Users" and 
"Administrators" will have pre-configured permissions for Studio302. If the user is 
logged on a domain, the groups "Domain Users" and "Domain Admins" will have pre-
configured permissions for Studio302. Therefore, these groups must be initially 
configured in the DCOM properties according to the workgroup or domain to which the 
computer belongs. 

 
 
Accessing the DCOM properties 
 
To start DCOM configuration, type DCOMCNFG.EXE from the Start menu. 
 
Use the Start Menu option or the Windows button option directly on the keyboard. 
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Figure B.2. Running Dcomcnfg 

 
 
The DCOM configuration tool should take a few seconds to open and will be as shown in the 
following figure. 
 

 
Figure B.3 Component Services 

 
 
Click Computers and then right-click My Computer. Select Properties. 
 

 
Figure B.4. Accessing computer properties 

 
 
In the dialog box, select the Default Properties tab and the option Enable Distributed COM on 
this computer should be marked. 
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Figure B.5. Default properties 

 
 
There are two possibilities to configure the DCOM properties: 
- Default Access 
- Individual Component Access 

 
Default Access Configuration 
This procedure will configure the permissions for all of the components in the DCOM. It will not be 
necessary to configure the DCOM permissions for each Studio302 component. 
 
In the Component Services window, right-click the icon My Computer and select the option 
Properties. In the My Computer Properties dialog box, select the COM Security tab. 
 

 
Figure B.6. Access permissions 
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Click the button Edit Default in the Access Permissions area. Add the users and groups related to 
Studio302 and select Local and Remote Access permissions for each user and group added. 
 
Click the button Edit Default in the Launch and Activation Permissions area and repeat the 
procedure to add users and groups related to Studio302. Select Local and Remote Launch, and 
Local and Remote Activation permissions for each user and group added. 
The figure below shows an example for the groups "Users" and "Administrators": 
 

 
Figure B.7 Launch and activation permissions 

 
 
Individual Component Access Configuration 
 
This procedure will configure the permissions for each Studio302 component in the DCOM. The list 
below shows the components that will be configured manually: 
 
Studio302 Components 
 

 
 
 

NOTE 
If AssetView is installed on your machine, include the AssetView user and groups to 
each of the components indicated above 

 
The following example will describe the procedure to configure the component SmarWatcher. Refer 
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to this example to configure all components listed above. 
 
1. In the Component Services window, expand the Console Root tree and locate the DCOM 

Config folder: Component Services > Computers > My Computer > DCOM Config. 
2. The DCOM components will be listed. The user can click the menu View > Detail to view a 

detailed list of components. 
3. Locate the component SmarWatcher with the corresponding AppID. 

 

 
Figure B.8. Configuring DCOM properties of SmarWatcher component 

 
 
4. Right-click this component and select Properties. 
 
5. In the Component Properties dialog box, select the Security tab. 
 

 
Figure B.9. Configuring the security 

 
 
6. In the Launch and Activation Permissions area, select the option Customize and click Edit. 
7. Add the Studio302 groups and select Local and Remote permissions for all groups.  
8. Return to the Component Properties dialog box. In the Access Permissions area, select the 

option Customize and click Edit. Add the Studio302 groups as described on item 7. 
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9. Return to the Component Properties dialog box and select the Identity tab. Mark the option 
The interactive user and click Ok to conclude. 

 

 
Figure B.10. Identity tab 

 
 
10. Repeat these steps to configure all components listed at the beginning of this subsection. 
 
 
Configuring the DCOM properties for AssetView groups 
 
If AssetView is installed on your machine, it will be necessary to configure DCOM permissions for 
these additional user and groups: 
 
Administrators - Group 
Interactive - Group 
System - Group 
ASP.NET - User 
Engineer - Group 
AssetViewGuest - Group 
  
The procedure to configure DCOM permissions for AssetView Users and Groups is the same 
described for Studio302 Users and Groups. 
 
When configuring the Default Access, add the AssetView user and groups indicated above to the 
list of users and groups in the Access Permissions dialog box and the Launch Permissions 
dialog box, selecting Local and Remote permissions. Refer to the topic Default Access 
Configuration. 
 
When configuring Individual Component Access, add the AssetView user and groups indicated 
above to the following AssetView component and to the list of other components indicated 
previously: 
 

 
 
Refer to the topic Individual Component Access Configuration. 
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